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Accessing Data from the Web Interface

This chapter provides information about accessing Cisco Mobile Wireless Transport Manager (MWTM) 
data from the MWTM web interface by using a web browser. 

This chapter contains:

• Supported Browsers, page 11-1

• Accessing the MWTM Web Interface, page 11-2

• Overview of the MWTM Web Interface, page 11-3

• Displaying the Home Page, page 11-11

• Downloading the MWTM Client from the Web, page 11-12

• Displaying Alarms and Events, page 11-14

• Displaying Summary Lists, page 11-14

• Displaying Status and Summary Reports, page 11-15

• Viewing Report Status, page 11-15

• Viewing Historical Statistics Report Settings, page 11-18

• Tools, page 11-19

• Understanding Groups, page 11-23

• Viewing Statistics, page 11-28

Supported Browsers
The MWTM web interface is supported on the following browsers:

• Microsoft Internet Explorer version 6.0 and 7.0 on Microsoft Windows operating system

• Mozilla Firefox 2.0 on Solaris 9 and Red Hat Linux Enterprise AS 4.0 operating system

• Mozilla Firefox 3.5+ on Solaris 10 and Red Hat Linux Enterprise 5.3 and Microsoft Windows 
operating systems.

Note The first time you attempt to connect to the MWTM server using Firefox 3.0, you must add an 
exception to allow the connection. See Importing an SSL Certificate to an MWTM Client, 
page 2-25 for more information.
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Checking Your Browser
To check your browser and screen settings, from the MWTM web interface Home page, select Browser 
Checker. 

Note Opening the MWTM in an unsupported browser generates a warning. Also, if JavaScript is not enabled, 
the MWTM web interface cannot function.

The Browser Checker window contains:

Accessing the MWTM Web Interface
The home page of the MWTM web interface is the first window to appear when you launch the MWTM 
web interface. 

To access the MWTM web interface, use one of these methods:

• Open a browser and enter http://mwtm_server:1774 in the Address field. (1774 is the default port).

Note Accessing the MWTM web interface through a URL other than http://mwtm-server:1774 is not 
supported. 

• From the MWTM client interface, choose View > MWTM Web Links > Home.

The MWTM Home page window opens in the browser window. For details about the Home page, see 
Displaying the Home Page, page 11-11.

Pane or Field Description

Browser Information

Browser The name and version of the browser you are using. 

Browser User Agent Text string sent to identify the user agent to the server. Typically includes information such as the 
application name, version, host operating system, and language.

Platform The platform type. For example, Win32.

Cookies Enabled Whether you have cookies enabled on the browser (Yes or No). 

Javascript Enabled Whether Javascript is enabled (Yes or No).

AJAX Component The Asynchronous JavaScript and XML (AJAX) component sends asynchronous HTTP update 
requests. The MWTM web application is only accessible to web browsers that have an AJAX 
component enabled. Typical values include XMLHttpRequest (for Mozilla-based browsers) and 
MSXML2.XmlHttp (for IE 6).

Screen Information

Size Resolution of the display; for example, 1600 x 1200. 

Color Depth Depth of the color display; for example, 16. 
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Overview of the MWTM Web Interface
The MWTM web interface shows basic information about the events and objects that the MWTM 
manages. The MWTM web interface shows:

MWTM Web Interface Navigation Tree
You can easily navigate the features of the MWTM web interface by using the navigation tree in the left 
pane. By default, the navigation tree is sorted by alarm severity, with objects having the most severe 
alarms appearing at the top of the tree.

Note To learn more about alarm severity, see Chapter 9, “Managing Alarms and Events.”

To view detailed information about a selection in the navigation tree, click the item in the tree. The 
content area in the right pane shows details about the chosen item. A plus (+) or minus (-) just to the left 
of the item indicates whether the item has subtending items under its domain. 

The MWTM automatically updates the navigation tree when changes occur to discovered nodes or to the 
network. When any changes occur in the MWTM client navigation tree, the MWTM web interface 
reflects these changes in its navigation tree. For example, if you delete a node in the MWTM client, the 
MWTM web interface removes that node from its navigation tree. 

Note For information about the navigation tree in the MWTM client interface, see MWTM Client Navigation 
Tree, page 3-16.

Pane Description

Title Bar Shows:

• Mobile Wireless Transport Manager, version, and server name

• Managed networks (can be any combination of IP-RAN, ITP, CSG1, CSG2, GGSN, BWG, HA, 
PDNGW, SGW, PCRF, and PDSN)

• Logout (appears only if you enable user access; see Configuring User Access, page 2-1)

• Help—Click this link to access context-sensitive online help

• Preferences—Click this link to access preferences that you can change from the web interface (see 
Changing Web Preference Settings, page 5-18)

Location bar Shows where you currently are in the MWTM navigation tree.

Navigation Tree In the left pane, shows a tree of information organized by categories (see MWTM Web Interface 
Navigation Tree, page 11-3).

Content Area In the right pane, shows detailed information about the object chosen in the navigation tree (see MWTM 
Web Interface Content Area, page 11-5).
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The MWTM web interface navigation tree contains:

GUI Element Description

Sort tree by name

Sorts all content in the navigation tree alphabetically by name. 

Sort tree by status

Sorts all content in the navigation tree by status, from the highest alarms to the lowest.

Home Shows links to MWTM client software, Cisco documentation, and information about the MWTM on the 
Cisco web (see Displaying the Home Page, page 11-11).

Administrative The Administrative page of the MWTM web interface provides the following tabs:

General—Shows MWTM system information including messages, logs, status, and properties. See 
Viewing General Tab Details, page 12-2.

SNMP—Provides access to SNMP (Simple Network Management Protocol) Editor to edit the SNMP 
settings. See Viewing SNMP Tab Details, page 12-22.

Credentials—Provides access to Device Credentials Editor to edit the credential details for the nodes. 
Viewing Credentials Tab Details, page 12-24.

Discovery—Allows you to discover the network. Viewing Discovery Tab Details, page 12-27.

User Management—Displays all users in the system along with the time of their most recent login, their 
access level, and their account status. Viewing User Management Tab Details, page 12-32.

If MWTM User-Based Access is enabled, only users with authentication level 3 (Network Operator) and 
higher can see all options. Users of all other levels see only the System Information and System Status 
panes.

Active Alarms Shows alarms (see Displaying Alarms and Events, page 11-14).

Event History Shows information about the events delivered by the MWTM event logger and event processor for events 
that the MWTM event logger and event processor deliver for all objects in the current network view (see 
Displaying Alarms and Events, page 11-14).

Summary Lists Shows summaries of all objects that the MWTM manages (see Displaying Summary Lists, page 11-14).

Reports Common Statistics—Shows common statistic reports for AAA, CPU, Interface, and Memory. For more 
information, see Viewing Common Statistics Reports, page 13-7.

ITP Statistics—Shows ITP statistic reports for AS, ASP, GTT Rates, Link, Link-Multi-Day, Linkset, 
MLR, MSU Rates, and SCTP. For more information, see Viewing ITP Statistics Reports, page 13-26.

Mobile Statistics—Shows mobile statistic reports for APN, Content Services, and PDSN. For more 
information, see Viewing Mobile Statistics Reports, page 13-85.

RAN Statistics—shows RAN statistic reports for PWE3 and RAN-Optimized. For more information, 
see RAN-Optimized Reports, page 13-178.

ITP Accounting—Shows ITP accounting reports for MTP3, AS/ASP, and GTT. For more information, 
see Viewing ITP Accounting Reports, page 13-192.

Mobile Subscribers—Shows subscriber account reports for HA, CSG, GGSN, and BWG. For more 
information, see Viewing Mobile Subscribers Reports, page 13-195.
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MWTM Web Interface Content Area
The content area of the MWTM client interface is fully described in MWTM Client Content Area, 
page 3-17. That description also applies to the web interface. Additional navigational features that 
appear only in the web interface include:

• Customizing Date Ranges, page 11-5

• Using the Toolbar, page 11-6

Customizing Date Ranges

Some windows require that you select date ranges for generating historical graphs (see Displaying 
RAN-O Statistics, page 11-28) and forwarding traps. Standard date ranges (for example, Last 24 Hours 
or Last 7 Days) are available from a drop-down menu. However, if you want to customize the date range:

Step 1 Click the Customize Date and Time Range tool  in the toolbar of the content area. A dialog box 
appears. 

Step 2 Enter a:

a. Begin Date and End Date; or, select those dates by clicking the Calendar tool . 

b. Begin Hour and End Hour from the drop-down menus, if they are available.

Note The dialog box shows an error if the End Date is equal to or less than the Begin Date. Correct 
the error before proceeding. 

Step 3 Click OK to accept the date and time changes; or, Cancel to cancel this operation.

The MWTM web interface generates a report for the specified time period.

File Archive Events—Shows archived events (see Viewing Archived Event Files on the Web, page 9-23).

Common Statistics—Shows archived common statistic reports. For more information, see Viewing File 
Archive Common Reports, page 13-204.

ITP Statistics—Shows archived ITP statistic reports. For more information, see Viewing File Archive 
ITP Reports, page 13-210.

Mobile Statistics—Shows archived Mobile statistic reports. For more information, see Viewing File 
Archive Mobile Reports, page 13-223.

RAN Statistics—Shows archived RAN statistic reports. For more information, see Viewing File Archive 
RAN Reports, page 13-236.

Tools Provides tools for launching CiscoWorks, CiscoView, and Device Center. Also provides a search tool 
for Home Agent (HA) and Gateway GPRS Support Node (GGSN) subscribers (see Tools, page 11-19).

Groups Displays user-defined groups (see Understanding Groups, page 11-23).

DEFAULT View Shows a current list of nodes in the DEFAULT view.

GUI Element Description
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Using the Toolbar

Depending upon the object you select in the navigation tree, the web interface toolbar provides these 
tools and options:

Tool or Function Description

Last Updated Date and time the MWTM last updated the information on the page.

Page Shows where you are (page X of X total pages) and lists the total number of entries.

 Refresh Forces a refresh of the current web page. Click this icon to refresh the current page.

Status Refresh Interval Allows you change the default refresh interval of 180 seconds. Enter a value between 180 and 900 
seconds. 

Note Changes you make are temporary to the current page. Navigating away from the page sets 
the status refresh interval back to the default setting. To change the default setting, see 
Changing Web Preference Settings, page 5-18.

Page Size Drop-down list of different page sizes (the number of table rows in the display). Click the 
drop-down arrow to select a different value. The value that you select becomes the default page size 
for all pages in the web interface.

The title bar displays the current page and total number of table entries.
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Quick Search Text box to filter the objects listed under the Summary List tables (Except for IP Addresses and 
Point Code tables). Enter the string in the text box to filter the table by and then press Enter. The 
rows under the table are filtered based on the string entered.

Below are the details for each Summary table about which columns are used for looking for the 
filtered string:

• Alarms: Internal ID, Node, Feature

• Nodes: Internal ID, Name, Primary SNMP Address, Node Type, Feature, Software Version, 
Serial Number, Reboot Reason, Status Reason

• Signaling Points: Internal ID, Name, Node, Network Name, Point Code, Variant, Network 
Indicator, Status Reason

• Linksets: Internal ID, Name, Node, Signaling Point, Local Point Code, Adjacent Point Code, 
Linkset Type, Status Reason

• Links: Internal ID, Node, Signaling Point, Linkset, Type, Status Reason

• Application Servers: Internal ID, Name, Node, Signaling Point, Protocol, Routing Key, Traffic 
Mode, Status Reason

• Application Server Processes: Internal ID, Name, Node, Local IP Address, Status Reason

• Application Server Process Associations: Internal ID, Name, Node, Signaling Point, 
Application Server, Protocol, Congestion Level, Status Reason

• Signaling Gateway Mated Pairs: Internal ID, Name, Mate, Node, Congestion Level, Status 
Reason

• Interfaces: Internal ID, Name, Node, Interface Type, Status Reason

• Cards: Internal ID, Name, Node, Card Type, Model Name, Description, Status Reason, 
Hardware Version, Firmware Version, Software Version

• RAN Backhauls: Internal ID, Name, Node, Location, Peer Name, Peer Node, Type, Status 
Reason

• RAN Shorthauls: Internal ID, Name, Node, Type, Location, Peer Name, Peer Node, Interface 
Type, Status Reason

• PWE3 Backhauls: Internal ID, Name, Node, Peer Name, Peer Node, Status Reason

• PWE3 Virtual Circuits: Internal ID, Name, Node, Peer Name, Peer Node, Type, PSN Type, 
Remote Interface String, Description, Status Reason

• Access Point Names: Internal ID, Name, Status Reason

• Software Versions: Name, Node Type, Software Version, Software Description

> Advances the display to the next page of information.

>> Advances the display to the last page of information.

< Advances the display to the previous page of information.

<< Advances the display to the first page of information.

 Modify event filter Opens the Event Filter dialog box. You can create a filter to display only the events in which you 
are interested (see Setting Alarm or Event Filters, page 9-11).

 Remove filter Applies or removes a filter that you created. 

Tool or Function Description
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Archived Link that shows only archived alarms or events. This link appears when you select Event History 
or Active Alarms in the navigation tree. It also appears when you click the Alarms tab or Recent 
Events tab for a specific object.

Caution In the Server.properties file, you can limit the number of rows in the archived events table 
with the MAX_ARCHIVED_EVENT
_DB_ROWS property. The default value is 200,000. Increasing this value can have 
severe impact on server performance and can cause the server to run out of memory.

 Customize Date 
and Time Range

Opens the Customize Date and Time Range dialog box (see Customizing Date Ranges, page 11-5).

 Graph Series 
Editor

Opens the Graph Series Editor dialog box, which provides a check box for each available data 
series. Check the check box to display a series, and uncheck the check box to hide a series. 

If you click OK without selecting a series, it is the same as clicking Cancel.

By default, the MWTM displays no more than 12 series by default. To change this default setting, 
see Display Series Dialog Box, page 8-109.

Run Runs the report type for the chosen duration.

 Export the report 
as a CSV file

Exports the data in the table to comma-separated value file (CSV file). You can save this file to disk 
or open it with an application that you choose (for example, Microsoft Excel).

Data Range Label that shows the chosen time range for the historical statistics.

Type Drop-down list of report types.

Duration Drop-down list of default time ranges. Select one of these options, then click the Run tool. To 
specify a nondefault time range, click the Customize Date and Time Range too.

Output Drop-down menu that provides these options:

• Graph—Displays statistical data in graphs and tables

• Table—Presents statistical data in tabular format only

• CSV—Exports statistical data using comma-separated values

Sort Parameter Used in the graph output of certain reports to select the criteria for including a top set of series and 
for ordering the corresponding graphs displayed.

Pause Pauses the page refresh feature. Click Pause to disable the page refresh that would normally occur 
after the Status Refresh Interval. Click Pause again to re-enable the Status Refresh Interval.

Edit Notes Enables you to edit or add notes for events.

Slow Poller Interval Allows you to change the default slow poller interval of 60 seconds. Enter a value between 60 and 
300 seconds. 

Note Changes you make are temporary to the current page. Navigating away from the page sets 
the status refresh interval back to the default setting. To change the default setting, see 
Changing Web Preference Settings, page 5-18.

Tool or Function Description
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Fast Poller Interval Allows you to change the default fast poller interval of 15 seconds. Enter a value between 5 and 60 
seconds. 

Note Changes you make are temporary to the current page. Navigating away from the page sets 
the status refresh interval back to the default setting. To change the default setting, see 
Changing Web Preference Settings, page 5-18.

Reset Counters Enables you to modify the counter reset settings to one of the following: 

• Show counters since reboot

• Show counters since last poll

• Show counters since user reset

Launch Drop-down list of applications you can launch:

• CiscoView

• CiscoWorks LMS Portal

• Device Center

• Node Home Page (This option is displayed based on the CiscoWorks user configuration)

After you choose the application, click the Run icon to launch it.

Severity Drop-down list of the severities of alarms or events. Severity can be Critical, Major, Minor, 
Warning, Informational, Indeterminate, or Normal. 

This drop-down list appears when you select Event History or Active Alarms in the navigation tree. 
It also appears when you click the Alarms tab or Recent Events tab for a specific object.

Change Severity Button to change the severity level of an alarm or event. 

To change the severity level, select one or more alarms or events by clicking the corresponding 
check boxes, choose a severity from the Severity drop-down list, then click Change Severity.

This button appears when you select Event History or Active Alarms in the navigation tree. It also 
appears when you click the Alarms tab or Recent Events tab for a specific object.

Clear Selection Link to clear the selection of one or more events or alarms. To select one or more alarms or events, 
check the corresponding check boxes. To clear the selection, click the Clear Selection link.

This button appears when you select Event History or Active Alarms in the navigation tree. It also 
appears when you click the Alarms tab or Recent Events tab for a specific object.

Tool or Function Description
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Toolbar for alarms and 
events

The web interface provides the same toolbar for alarms and events as the client interface. For full 
descriptions of these tools, see Toolbar Buttons, page 9-8.

Actions Drop-down menu appears when you hover over the Actions button. The Actions button is displayed 
for all the object based Summary Lists (i.e. except Alarms, Software Versions, IP Addresses, and 
Point Code), Management interfaces and Physical folders of the nodes under the navigation tree, 
and under the Details tab of all the objects.

Note Users with authentication level 1 cannot see the Actions button. Also, the Manage and 
Ignore options have separate permissions for Manage/Unmanage and Ignore/Unignore. The 
menu item is not shown if both the permissions are invalid.

Note The Action Menu appears in the Shorthauls tab for Backhauls and in the Nodes tab for 
APNs.

For all the objects/summary lists except APN the drop-down menu contains:

• Normal Poll Node—Polls the chosen nodes.

• Clean Poll Node—Polls all chosen nodes and removes any Unknown objects after the 
completion of the poll.

• Provision—Allows you to provision the objects.

• Ignore/Unignore—Ignores or stops ignoring the chosen object at the next polling cycle.

• Manage/Unmanage—Labels the chosen node Managed or Unmanaged. The option Manage or 
Unmanage is displayed based on the selected item.

• Allow Trap Processing/Disallow Trap Processing—Enables or disables the MWTM to process 
traps from the chosen node. The option Allow Trap Processing or Disallow Trap Processing is 
displayed based on the selected item.

• Delete—Deletes the chosen object.

For Management interfaces and Physical folders of the nodes, the drop-down menu contains:

• Ignore/Unignore—Ignores or stops ignoring the chosen object at the next polling cycle.

For APNs the drop-down menu contains the following options:

• Search for APN Subscriber—Used to search for a specific subscriber across one or more 
designated GGSN, PDNGW, and SGW subscribers. See Searching for APN Subscribers, 
page 11-23 for more information.

• Ignore/Unignore—Ignores or stops ignoring the chosen object at the next polling cycle.

• Delete—Deletes the chosen object.

Note For the nodes that are not manageable, the Actions menu contains only Ignore and Delete 
options.

The Details tab of the groups created contains the Actions drop-down menu which contains the 
following options: 

• Batch Provision—Used to perform Batch Provisioning. See Batch Provisioning, page 11-26.

Note The Actions button does not appear for the groups if they do not have a batch file of the 
corresponding node type.

Tool or Function Description
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Displaying the Home Page
The MWTM web interface Home page provides access to MWTM client software, Cisco documentation, 
and information about the MWTM.

To access the Home page of the MWTM web interface, click Home under the navigation tree in the left 
pane. 

The content area in the right pane shows these GUI elements:

Pane GUI Element Description

Client Software Download Windows Client

Download Solaris Client

Download Linux Client

Browser Checker

Shows the download instructions for the:

• Windows client

• Solaris client

• Linux client

• Information about the browser and screen display

For details, see Downloading the MWTM Client from the Web, 
page 11-12.

MWTM on 
Cisco.com

MWTM Home Page

MWTM Software Download 
Page

Latest MWTM 
Documentation

Engineering Software Updates 
(FTP)

MWTM Supported IOS 
Releases

Shows hyperlinks to:

• MWTM information on the Cisco website

• MWTM software download from Cisco.com

• Most recent versions of MWTM documentation

• Software updates provided by Cisco Engineering

• Supported IOS Releases document for the current release

For details, see Accessing Software Updates and Additional Information, 
page 11-13.

Documentation Help Home Page

Release Notes

Install Guide

User Guide

OSS Integration Guide

Alarm Guide

Frequently Asked Questions

MWTM Server Help 
Command

Shows: 

• Online Help system for the MWTM

• PDF versions1 of the:

– Release Notes for the Cisco Mobile Wireless Transport Manager

– Installation Guide for the Cisco Mobile Wireless Transport 
Manager

– User Guide for the Cisco Mobile Wireless Transport Manager

– OSS Integration Guide for the Cisco Mobile Wireless Transport 
Manager

– Alarm Guide for the Cisco Mobile Wireless Transport Manager

• HTML version of the FAQs

• CLI output of the mwtm help command

For details, see Viewing the MWTM Technical Documentation, 
page 11-13.

1. To access the latest versions, go to the parent index for Cisco MWTM user documents: 
http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html
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Downloading the MWTM Client from the Web
You can access the MWTM client installation software for Linux (unsupported), Solaris, and Windows 
from the MWTM web interface Home page. This access is useful if you do not have the CD-ROM, or if 
you prefer to download the software by using your web browser. Once you have downloaded the MWTM 
client installation software to your workstation, you must install the software on your local system.

For more information about installing the MWTM client software by using a web server, see the 
following chapters in the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.3:

• “Installing the MWTM on Solaris”

• “Installing the MWTM on Windows”

• “Installing the MWTM on Linux” 

Related Topics

• Downloading the Solaris Client, page 11-12

• Downloading the Windows Client, page 11-12

• Downloading the Linux Client (Unsupported), page 11-12

Downloading the Solaris Client
To access the MWTM Client for Solaris page, select Download Solaris Client.

The web interface shows the supported Solaris versions and instructions for downloading the Solaris 
client. See the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.3 for a detailed 
procedure.

To start the client after installation, add the /opt/CSCOsgmClient/bin subdirectory to your path, then 
enter the mwtm client command from the command line.

Downloading the Windows Client
To access the MWTM Client for Windows page, select Download Windows Client.

The web interface shows supported Windows versions and instructions for downloading the Windows 
setup program. After downloading the setup program onto your desktop or other Windows directory, 
double-click the setup.exe icon to start the setup program and launch the installation wizard. See the 
Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.3 for detailed procedures.

To start the client after installation, launch it from the Windows Start menu or double-click the MWTM 
Client icon on your desktop.

Downloading the Linux Client (Unsupported)
To access the MWTM Client for Linux page, select Download Linux Client. 

Note The MWTM does not support the MWTM client for Linux. Use the MWTM Linux client under 
advisement.
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The web interface shows the supported Linux versions and instructions for downloading the Linux 
client. See the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.3 for a detailed 
procedure.

To start the client after installation, add the /opt/CSCOsgmClient/bin subdirectory to your path, then 
enter the mwtm client command from the command line.

Accessing Software Updates and Additional Information
You can access this information about the MWTM from the MWTM web interface Home page. To:

• View information about the MWTM or any other Cisco product available on Cisco.com, select Cisco 
Home Page.

• Read Cisco literature associated with the MWTM, including product data sheets, Q and As, and 
helpful presentations, select MWTM Home Page.

• Access software updates for the MWTM from Cisco.com for FTP, select Engineering Software 
Updates (FTP). The Cisco Systems Engineering FTP server page appears.

• Access software updates for the MWTM from Cisco.com, select MWTM Software Download 
Page. The Software Download page for the MWTM appears.

• Access the most recent versions of customer documentation for the MWTM, select Latest MWTM 
Documentation. The Cisco Mobile Wireless Transport Manager documentation page on Cisco.com 
appears. From this page, you can view the latest versions of MWTM release notes, installation 
guides, and end-user guides.

Note If you cannot access Cisco.com from your location, you can always view the customer 
documentation that was delivered with the MWTM software. See the Viewing the MWTM 
Technical Documentation, page 11-13.

Viewing the MWTM Technical Documentation
From the MWTM web interface Home page, you can view this MWTM technical documentation. To 
view the:

• Entire Cisco Mobile Wireless Transport Manager Help System, select Help Home Page.

• Entire User Guide for the Cisco Mobile Wireless Transport Manager 6.1.3 as a PDF file on the web, 
using the Adobe Acrobat Reader, select User Guide (PDF).

• Entire Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.3 as a PDF file on 
the web, using the Adobe Acrobat Reader, select Install Guide (PDF).

• Entire Release Notes for the Cisco Mobile Wireless Transport Manager 6.1.3 as a PDF file on the 
web, using the Adobe Acrobat Reader, select Release Notes (PDF).

• Frequently Asked Questions (FAQs) about the MWTM, select Frequently Asked Questions.

• Syntax for every MWTM command, select MWTM Server Help Command.

Caution These PDF versions of technical documents might not be the latest versions. For the latest versions, go 
to: http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html.
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Displaying Alarms and Events
To display alarms in the web interface, click Active Alarms in the navigation tree, or select an object in 
the navigation tree and click the Alarms tab.

To display events in the web interface, click Event History in the navigation tree, or select an object in 
the navigation tree and click the Recent Events tab.

Viewing alarms and events in the web interface is essentially the same as viewing them in the MWTM 
client. Only minor differences exist:

• A paging feature for paging through large tables.

• A refresh interval that you can change.

• An Archived link for viewing archived alarms.

• Alarm selection by check box and a Clear Selection link.

• Severity drop-down list and a Change Severity button.

For detailed descriptions of these tools, see the “Using the Toolbar” section on page 11-6.

For descriptions of the columns, see the “Right-click Menus” section on page 9-10.

Displaying Summary Lists
Displaying Summary Lists in the web interface is essentially the same as displaying them in the MWTM 
client. Only minor differences exist. Clicking on an object under the Summary Lists in the web interface 
causes the content area to show information about the object. 

For details on:

• Navigating table columns, see Navigating Table Columns, page 5-23. 

• The toolbar, see Using the Toolbar, page 11-6.

For complete information about Summary Lists, see the Displaying Object Windows, page 7-2.

Displaying Software Versions
The Software Versions table lists the software versions for each node the MWTM manages.

To access the Software Versions page:

• From the Web interface navigation tree, choose Summary Lists > Software Versions.

• From the MWTM main window, choose View > MWTM Web Links > Software Versions.

For details on:

• Navigating the columns of the Software Versions table, see Navigating Table Columns, page 5-23. 

• The toolbar, see Using the Toolbar, page 11-6.
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The Software Versions table contains:

Displaying Status and Summary Reports
You can view a table, graph, or CSV file that shows the overall state of the available MWTM reports, the 
time the server took to gather data from the network and store it in the database, and enable or disable 
reports from the report page. You can also run hourly and daily performance summary reports. 

Step 1 In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears 
as described in Viewing Report Status, page 11-15.

Step 2 From the Type pulldown menu, select one of the following types of reports:

• Report Status—See Viewing Report Status, page 11-15.

• Performance Summary Hourly—See Performance Summary Hourly Report, page 11-16.

• Performance Summary Daily—See Performance Summary Daily Report, page 11-17.

Step 3 Select a duration and output type. See the “Using the Toolbar” section on page 11-6 for more information 
about these fields.

Viewing Report Status
The Reports page in the MWTM web interface allows you to view a table, graph, or CSV file that shows 
the overall state of the available MWTM reports. You can also enable or disable reports from the report 
page.

Note Only reports that run on a regularly scheduled interval are displayed in the Hourly and Daily data. 
Reports that run continuously are not displayed.

Note Only reports that run on a regular scheduled interval display information in the following columns:Last 
Start Time, Last End Time, and Duration. Reports that run continuously display N/A for these columns. 
A report that has not yet run has Unknown in the above columns.

Column Description

Name Name of the node.

Node Type Type of node.

Software Version Software version used by the node.

Software Description Full software version information. 
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To access the main Reports page:

Step 1 Do one of the following:

• In a web browser, launch the MWTM web interface (see Accessing the MWTM Web Interface, 
page 11-2). In the navigation tree, click Reports. 

• From the MWTM client, in the MWTM main window, choose View > MWTM Web Links > 
Reports.

The Reports page in the content area shows the Report Type and the status (enabled or disabled). If you 
have generated a report, a green status ball and the word “Enabled” appear in the Status column. If you 
have not generated a report, a red status ball and the word “Disabled” appears.

Note Clicking a Report Type takes you directly to the report data page.

The Status column indicates whether you have enabled or disabled data gathering for the specified report 
type.

Step 2 To enable a report in the MWTM Web interface, click “Disabled” in the Status column. The Status 
changes “Enabled” and a green status ball appears.

Performance Summary Hourly Report
The Performance Summary Hourly Report shows the time it takes to gather the data from the network 
and store it in the database. This report shows data for reports that are invoked via an hourly cronjob only 
and not reports that run continuously.

Step 1 In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears 
as described in Viewing Report Status, page 11-15.

Step 2 From the Type pulldown menu, select Performance Summary Hourly.
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Performance Summary Daily Report
The Performance Summary Daily Report shows the time it takes to gather the data from the network and 
store it in the database. This report shows data for reports that are invoked via a daily cronjob only and 
not reports that run continuously.

Step 1 In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears 
as described in Viewing Report Status, page 11-15.

Step 2 From the Type pulldown menu, select Performance Summary Daily.

GUI Element Description 

Toolbar Provides functions to select a report type, duration, output type. See Using the Toolbar, page 11-6.

Table If you select the Output Type Table, the table contains:

• Report Type—Type of report.

• Start Time (timezone)—Time the report started.

• End Time (timezone)—Time the report ended. 

• Duration (secs)—Time it took to run the report.

• Object Count—Number of objects on which the report was run.

Note If the Output Type is Table or CSV, the same data is presented but the column headings are 
labeled by data type.

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Duration (Secs) If Output Type is Graph, Y-axis label that shows duration in second. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar 
to show the period for which no data is available.

Time If Output Type is Graph, X-axis label that shows a historical time scale and the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for output.
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Viewing Historical Statistics Report Settings

Step 1 In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears 
as described in Viewing Report Status, page 11-15.

Step 2 Click the Settings tab. The Historical Stats Report Settings information is displayed.

You can click on Disabled or Enabled to change the state of any of the reports.

You can click on any field, except for the Reports Directory field, to modify its value.

GUI Element Description 

Toolbar Provides functions to select a report type, duration, output type. See Using the Toolbar, page 11-6.

Table If you select the Output Type Table, the table contains:

• Report Type—Type of report.

• Start Time (timezone)—Time the report started.

• End Time (timezone)—Time the report ended. 

• Duration (secs)—Time it took to run the report

• Object Count—Number of objects on which the report was run. 

• If the Output Type is Table or CSV, the same data is presented but the column headings are 
labeled by data type.

Expand to Full Screen If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier 
viewing.

Duration (Secs) If Output Type is Graph, Y-axis label that shows duration in second. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar 
to show the period for which no data is available.

Time If Output Type is Graph, X-axis label that shows a historical time scale and the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for output.

Bits/Sec or Bytes/Sec If Output Type is Graph, Y-axis label that shows traffic rate in bits per second. The Y axis 
automatically scales to the interface speed. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar 
to show the period for which no data is available.
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Tools
To access launch and search tools, click Tools in the navigation tree of the MWTM web interface. The 
following options are available:

• Launch Tools, page 11-20

• Events and Alarms, page 11-20

• Search Tools, page 11-22

Field Description

General Settings Reports Directory Specifies the directory in which the MWTM reports are stored. You 
must use the CLI to change the directory in which the reports are 
stored; you cannot click on this field to modify it.

Time Mode Specifies the time mode, either 12-hour or 24-hour, for the reports.

Master Report Flag If this option is enabled, the individual report settings are used. If this 
is option is disabled, all reports are turned off.

Perform Disk Space 
Checking

Specifies whether disk space checking is enabled or disabled.

Export Reports Specifies whether to automatically generate reports in CSV format.

15 Min Stats Aging (Days) Specifies the database aging value for 15-minute statistics. When 
records exceed the specified value, they are aged out of the database.

Hourly Stats Aging (Days) Specifies the database aging value for hourly statistics. When records 
exceed the specified value, they are aged out of the database.

Daily Stats Aging (Days) Specifies the database aging value for daily statistics. When records 
exceed the specified value, they are aged out of the database.

Monthly Stats Aging (Days) Specifies the database aging value for monthly statistics. When 
records exceed the specified value, they are aged out of the database.

Custom Stats Aging (Days) Specifies the database aging value for custom statistics. When 
records exceed the specified value, they are aged out of the database.

ITP Report Settings Show links with no capacity 
set (nullcaps)

Specifies whether to show links/linksets that do not have planned 
send and receive capacities. 

Show SCTP IP Links Specifies whether to show SCTP IP links. 

High In-Service Ratio 
Threshold

Displays the high value for the In-Service ratio threshold.

High Utilization Ratio 
Threshold

Displays the high value for the utilization ratio threshold.
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Launch Tools
If you have integrated with a CiscoWorks server, one or more of the following applications appears in 
the Launch pane as active links:

• CiscoView

• CiscoWorks LMS Portal

• Device Center

The name of the server appears in parentheses following the application names. To launch an application, 
click the application name. See Integrating the MWTM with Other Products, page 5-36.

Events and Alarms
The Events and Alarms pane contains the following links:

• Client disconnect sound

• Alarm Synchronization

The Events and Alarms tool allows you to select a sound to be played when the client loses its connection 
to the MWTM server. By default, no sound is played when the client loses its connection to the server. 
You must select a sound to be played. 

Step 1 Click Tools in the navigation tree of the MWTM web interface. From the Client disconnect sound 
pulldown menu, select a sound. The sound you selected is saved. 

Step 2 After selecting a client disconnect sound, click Play to sample the sound. 

Note Make sure you are not logged into the MWTM client at the same time that you are changing the client 
disconnect sound in the MWTM web interface. Any sound changes you make using the MWTM client 
override changes you make using the web interface.

You can use the MWTM client interface to create and change event sound filters for the MWTM client 
as explained in Setting Sounds for Events at an MWTM Client, page 9-36.

Alarm Synchronization

Click the Alarm Synchronization link to open the Alarm Synchronization page. This page contains the 
following toolbar buttons and the panes:

• Toolbar Buttons, page 11-21

• Trap Target Information, page 11-21

• Match Alarms by Date Range, page 11-21

• Match Alarms by Alarm Id Range, page 11-22
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Toolbar Buttons

The page contains the following toolbar buttons:

Trap Target Information

The Trap Target Information pane contains the following fields:

Match Alarms by Date Range

The Match Alarms by Date Range pane contains the following fields:

Field or Button Description

Back Use this button to return to the previous page.

Forward 
Alarms

Click this icon to forward the alarms within the specified range.

Field or Button Description

Target Host 
Name or IP 
Address

Enter the destination host name or IP address in this text field.

Target Port Host port number to which the MWTM should forward traps.

SNMP 
Community 
String

SNMP community string that the MWTM should include in forwarded traps.

SNMP Version Trap version to forward. Valid values are 1 and 2c.

Trap Type Type of trap that the MWTM should forward to this host. Valid trap types are:

• CISCO-SYSLOG: The CISCO-SYSLOG-MIB clogMessageGenerated trap.

• CISCO-EPM: CISCO-EPM-NOTIFICATION-MIB 
ciscoEpmNotificationRev1 trap.

• CISCO-EPM-2: CISCO-EPM-NOTIFICATION-MIB 
ciscoEpmNotificationRev2 trap.

Field or Button Description

Customize 
Date and 
Time 

Range

Opens the Customize Date and Time Range dialog box (see Customizing Date 
Ranges, page 11-5).

Clear Click this icon to clear the alarm dates and enable match by ID section.

Start Alarm 
Change Time 

The start alarm change time to forward the traps.

End Alarm 
Change Time

The end alarm change time to forward the traps.
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Match Alarms by Alarm Id Range

The Match Alarms by Date Range pane contains the following fields:

Search Tools

Note You must have the Cisco Home Agent (HA) network enabled to use this tool (for details on enabling HA, 
see mwtm manage, page B-44).

The Search pane provides a tool that you use to search for a specific subscriber across one or more 
designated Cisco Home Agent (HA) routers or to search for GGSN, PDNGW, and SGW subscribers. 
These tools are useful for troubleshooting problems that subscribers might report. 

In the Search pane, click one of the following options:

• Search for Home Agent Subscriber (See Searching for Home Agent Subscribers, page 11-22)

• Search for APN Subscriber (See Searching for APN Subscribers, page 11-23)

Searching for Home Agent Subscribers

Step 1 Click Tools in the navigation tree of the MWTM web interface, then select Search for Home Agent 
Subscriber.

Step 2 Click the Identifier Type radio button:

• Network Access Identifier—Use this option if you know the subscriber’s network access identifier 
(NAI); for example, jdoe@xyz.com.

• IP Address—Use this option if you know the subscriber’s IP address

Step 3 Depending on your selection in Step 2, enter the subscriber’s NAI or IP address in the Mobile Node 
Identifier field.

Step 4 In the Select Groups to Search pane, click on the group(s) for which you want to search for Home 
Agents. This field is only available if you have previously created an HA config, HA report, or General 
group. (See Creating Groups, page 11-23).

Step 5 In the Select Home Agents to Search pane, check the check boxes of the Home Agents that you want to 
search. (The default setting is all Home Agents.) Click Select All to check all boxes and search all Home 
Agents. Click Deselect All to clear all check boxes.

Step 6 To conduct the search, click the Search button. 

The Search Results popup window appears.

Step 7 If the search successfully locates the subscriber, and you want to troubleshoot the problem, click the 
Troubleshoot Subscriber button in the Search Results popup. 

The MWTM automatically navigates to the Troubleshooting tab of the HA device.

Field or Button Description

Clear Click this icon to clear the alarm IDs and enable match by date section.

Start Alarm Id The start alarm ID to forward the traps.

End Alarm Id The end alarm ID to forward the traps.
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Step 8 For more information about troubleshooting devices by using the Troubleshooting tab, see Viewing 
Troubleshooting, page 8-40.

Searching for APN Subscribers

Step 1 Click Tools in the navigation tree of the MWTM web interface, then click Search for APN Subscriber.

Step 2 In the MSISDN field, enter the MSISDN for which you want to search.

Step 3 In the Select Groups to Search pane, click on the group(s) for which you want to search for GGSN, 
PDNGW, or SGW subscribers. This field is only available if you have previously created a GGSN config, 
GGSN report, PDNGW config, PDNGW report, SGW config, SGW report, or General group. (See 
Creating Groups, page 11-23).

Step 4 In the Select Nodes to Search field, select all the Nodes on which you want to search for the MSISDN 
you entered. Click Select All to check all boxes and search all the nodes. Click Deselect All to clear all 
check boxes.

Step 5 To conduct the search, click the Search button. 

The Search Results popup window appears.

Step 6 If the search is successful, you can select from the matching nodes to troubleshoot the subscriber by 
clicking the Troubleshoot Subscriber button in the Search Results popup.

Understanding Groups
MWTM allows you to create groups of nodes that can simplify operations. You can create groups using 
the MWTM web interface and then perform operations against all nodes of a group instead of performing 
the operation against each node individually. You can also perform searches on groups. For example, you 
can search for a home agent subscriber on nodes within a specific group. 

For provisioning groups, the master node is the first node in the group. The master node is used to 
determine provisioning commands.

Related Topics

• Creating Groups, page 11-23

• Editing Groups, page 11-25

• Viewing Group Summary Information, page 11-25

Creating Groups

Note This option is available to users with authentication level Power User (level 2) and higher.

You can create the following types of groups:
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Step 1 From the web interface, click Groups.

Step 2 Click the Create icon. The New Group form appears.

Step 3 Complete the New Group fields:

Note If a group contains non-existent nodes or if you add a node of the wrong type to a group, the 
group will be invalid.

Step 4 Click OK.

The Edit window appears displaying information about the group you just created. See Viewing Group 
Summary Information, page 11-25 for more information.

Related Topics

• Understanding Groups, page 11-23

• Editing Groups, page 11-25

• Viewing Group Summary Information, page 11-25

Field Description

Name Enter a name for the group

Type From the pulldown menu, select the group type:

CSG configuration

CSG report

GGSN configuration

GGSN report

General—Any node can be in the general group.

HA configuration

HA report

IPRAN configuration

RAN-O configuration

PDNGW configuration

PDNGW report

SGW configuration

SGW report

mSEF configuration
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Editing Groups
After you have created a group, you can add nodes to and remove nodes from the group. You can also 
order the nodes within the group. 

Note This option is available to users with authentication level Power User (level 2) and higher. If you do not 
have the required privileges you will not see the Edit tab.

Step 1 From the web interface, click Groups > group name.

Step 2 Click the Edit tab. The Group Settings pane displays the group name and group type.

Step 3 In the Group Members pane, specify to display available members by Nodes or by Groups. You might 
want to view members by Group if you want to copy all members of one group to another group. The 
available members or groups are displayed. 

Note Only valid nodes for a group are displayed in the Available members/groups list. A group is 
invalid if it contains non-existent nodes or if the group contains nodes of the wrong type.

Step 4 Click on a member or group to add to the specified group, then click Add. The member or group is added 
to the Selected Members list. 

Step 5 To remove a member, click on the member in the Selected Members list, then click Remove.

Step 6 To order the nodes in a group, use the Raise and Lower buttons. 

For provisioning groups, the master node is the first node in the group. The master node is used to 
determine provisioning commands.

Viewing Group Summary Information
From the web interface navigation tree, click Groups to display the Group Summary List.

Field Description

Name Name of the group.

Group Type Type of group.

Size Number of nodes in the group.

Notes Displays any notes attached to the group.

Valid Yes indicates the group is valid. No indicates the group is not valid. A group is 
invalid if it contains non-existent nodes or if the group contains nodes of the wrong 
type. 

Last Verified Time and date group was last verified. 
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Displaying Group Details

Step 1 From the web interface, click Groups > group name. You can click on any of the following tabs for more 
information about the specified group:

Details—See Viewing Group Details, page 11-26.

Notes—See Viewing Notes, page 7-43.

Events—Displays events associated with the nodes in the group only. See Displaying Alarms and Events, 
page 11-14.

Alarms—Displays alarms associated with the nodes in the group only. See Displaying Alarms and 
Events, page 11-14.

Edit—See Editing Groups, page 11-25.

Viewing Group Details

Step 1 From the web interface, click Groups > group name. 

Step 2 Click Details. Detailed information about the specified group is displayed. See Nodes Table, page 7-5 
for descriptions of the fields. 

The Group Member Verification Status field specifies that status of each group member as it exists in the 
group. If the group is not valid, this field indicates which node is causing the group to not be valid. 

Batch Provisioning
The MWTM provides a popup text field where you can type any CLI commands and then have those 
stored in a file on the server. These commands can then be used in batch operations to push out config 
changes to the nodes where there is no direct support in the wizard GUI interface.

The MWTM uses the existing "Groups" feature to create group objects. Once you have a group to 
provision (see Using the Provisioning Wizard, page 8-49), select the group from left panel and then 
choose Actions > Batch Provision from the toolbar. The page gets loaded with the Batch Provision 
page.

Note The Batch Provision option is available only for the users with authentication level 3 and above. Also, 
the Batch Provision is not available for a group of the type "Report".

The Batch Provision page contains:

Field or Button Description

Back Use this button to go back to the previous page.

Load File Opens the MWTM: File Dialog window, which allows you to load the batch files.
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MWTM: File Dialog

The MWTM: File Dialog window contains:

Save File Saves the changes you have made to the chosen batch file. The saved batch files are added in 
the path /opt/CSCOsgm/etc/batch with the naming convention 
"$Name.99.9(99).Generic.batch". 

Save As Click this to save the updated batch file with a new name, or to overwrite an existing batch 
file. Opens the MWTM: File Dialog window with the addition of a text field “Filename” 
where you can specify the new name for the batch file. If an existing file name is given in the 
"File Name" text field, a confirmation dialog box is displayed asking whether to overwrite 
the existing file. The saved batch files are added in the path /opt/CSCOsgm/etc/batch with the 
naming convention "$Name.99.9(99).Generic.batch".

Write Mem Click this check box to save the script to the running configuration.

Provision Allows you to perform batch provisioning for the nodes in the selected group.

Batch File Text area to display or edit the contents of the batch file. 

This text area is empty and the title displays “Batch File: No File” when there is no batch 
file loaded. Once the batch files are loaded (using the Load File option), the text area 
displays the contents of the loaded batch file and the title of the text area changes to 
Batch File: filename, where filename is the name of the batch file.

You can also enter the device level commands in this text area to provision the nodes in 
the selected group.

Field or Button Description

Field or Button Description

Batch File List The Batch File List pane contains the following columns:

• Type—Icon indicating the item in the table is a file.

• Name—Name of the batch file.

• Node Type—Type of node. See Nodes Table, page 7-5, for a list of the available node 
types.

• Last Modified—Date and time the batch file or folder was last modified.

• Size (bytes)—Size of the batch file or folder, in bytes.

OK Loads the chosen batch file and closes the dialog box. To load a batch file, select the file 
in the list and click OK. The batch file is loaded properly in the “Batch File:" text area 
panel of the "Batch Provision" page.

Delete Deletes the chosen file from the batch file list. The MWTM displays a confirmation 
message before deleting the file. 

Cancel Closes the dialog box without loading a batch file or saving any changes to the batch file 
list. 

Help Displays online help for the dialog box. 
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Viewing Statistics
You can use statistics for capacity planning and trend analysis. For example, you can generate graphs, 
tables, or CSV files:

• For a specified time range to display historical statistics for customer busy-hours. 

• To show the maximum send and receive traffic over a specified time period. 

• To show data on a 15-minute, daily, or hourly basis. 

MWTM provides two types of statistics:

• Real-time statistics—The MWTM provides real-time (not historical) performance statistics and 
error information occurring in real time. The MWTM client also displays graphs for real-time 
statistics. You use real-time statistics for troubleshooting active problem areas in your network. See 
Displaying RAN-O Statistics, page 11-28 and Displaying Error Statistics, page 11-31

• Historical reports (statistics). These reports are available on the MWTM web interface only.

These statistics vary by the time frame over which they are collected and stored and for some 
domains, the statistics gathered vary. For example, real-time SCTP Association Statistic Details 
describes link-level SCTP statistics collected every 15 seconds. The SCTP historical reports 
describe device-level SCTP statistics for all of the SCTP links on a specific device over 15 minute, 
hourly, and daily intervals. 

Displaying RAN-O Statistics
You can view real-time performance data for a shorthaul or backhaul interface in the MWTM:

• Web interface by selecting a shorthaul or backhaul interface in the navigation tree and clicking the 
Shorthaul Performance or Performance tab in the right pane.

• Client interface by right-clicking a shorthaul or backhaul interface in the navigation tree and 
clicking Performance History. The MWTM client interface provides access to RAN-O real-time 
performance statistics that you can use to troubleshoot problems that occur in real time. The zoom 
and navigation features quickly enable isolating and focusing on a problem area. 

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > IPRAN OS README.

• Client interface, choose View > MWTM Web Links > Administrative; then click IPRAN OS 
README.

The Performance tab shows one or more graphs depending on the type of report chosen. These graphs 
depict send and receive rates of optimized IP traffic over a specified time range. The graphs display the 
traffic in bits per second. Each data series shows maximum, minimum, and average rates of optimized 
traffic.
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The Performance tab for a backhaul interface shows total rates for GSM and UMTS traffic, including 
total error rates.

This section provides information about:

• Displaying Shorthaul Performance Statistics, page 11-29

• Displaying Backhaul Performance Statistics, page 11-29

Displaying Shorthaul Performance Statistics
The Shorthaul Performance tab for a shorthaul interface shows the maximum, minimum, and average 
rates for send and receive traffic. 

The Shorthaul Performance tab for a shorthaul interface contains: 

Displaying Backhaul Performance Statistics
The Performance tab for a backhaul interface shows minimum, average, and maximum traffic rates for 
send and receive traffic. You can also determine the percentage of backhaul utilization that various traffic 
types occupy. Error rates appear, too. 

GUI Element Description

Toolbar Provides functions to select a report type, duration, output type. See Using the Toolbar, page 11-6.

Type A comprehensive summary of minimum, average, and maximum capacity statistics for send and receive 
traffic on a RAN shorthaul. You can choose from 15-minute, hourly, or daily capacity summary reports, 
or choose a custom range.

Table If you select the Output Type Table, the table contains:

• Data Type—Type of data, send or receive

• Average—Average of the data across the chosen time range

• Minimum—Minimum value across the chosen time range 

• Minimum Timestamp EDT—Time the minimum value occurred 

• Maximum—Maximum value across the chosen time range 

• Maximum Timestamp EDT—Time the maximum value occurred

Note If the Output Type is Table or CSV, the same data is presented but the column headings are labeled 
by data type (for example, Send Average and Receive Average).

Expand to Full 
Screen

If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier viewing.

Bits/Sec or 
Bytes/Sec

If Output Type is Graph, Y-axis label that shows traffic rate in bits per second. The Y axis automatically 
scales to the interface speed. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar to show 
the period for which no data is available.

Time If Output Type is Graph, X-axis label that shows a historical time scale and the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for traffic rates.
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The Performance tab for a backhaul interface contains: 

GUI Elements Description

Toolbar Provides functions to select a report type, duration, output type, and the Graph Series Editor. See the 
“Using the Toolbar” section on page 11-6.

Type Report Type. If you choose a Capacity Summary report, the report shows a comprehensive summary of 
minimum, average, and maximum capacity statistics for total traffic (GSM-Abis and UMTS-Iub), total 
GSM-Abis traffic, and total UMTS-Iub traffic. You can choose from 15-minute, hourly, or daily capacity 
summary reports. Error rates appear, too.

If Output Type is Graph, statistics appear in these graphs:

• Top—Capacity statistics for send traffic rates, including percentage of backhaul utilization (right side 
of graph).

• Middle—Capacity statistics for receive traffic rates, including percentage of backhaul utilization 
(right side of graph).

• Bottom—Error counts for send and receive traffic.

Type (continued) If you choose a Minimum, Average, or Maximum Capacity report, the tables and graphs show capacity 
statistics for the backhaul interface. You can choose from 15-minute, hourly, or daily capacity reports.

If Output Type is Graph, send and receive rate statistics appear in separate panes. Each pane shows two 
fully expandable graphs:

• Top—Shows total (GSM-Abis and UMTS-Iub), total GSM-Abis, and total UMTS-Iub traffic rates, 
including percentage of backhaul utilization (right side of graph).

• Bottom—Shows traffic rates for each shorthaul interface that belongs to the backhaul.

Table Note Different tables appear depending on the report Type and Output Type selections.

If the Output Type is Graph, a table appears with these columns:

• Data Type—Type of data, send or received

• Average—Average of the data across the chosen time range

• Minimum—Minimum value across the chosen time range 

• Minimum Timestamp EDT—Time the minimum value occurred 

• Maximum—Maximum value across the chosen time range 

• Maximum Timestamp EDT—Time the maximum value occurred

Note If the Output Type is Table or CSV, similar data is presented but the column headings may vary. 
Also, if the value is N/A, that means no data is available.

Another table has these columns:

• Data Type—Category of error for which statistics are gathered. Types include optimization, missed 
packets, and miscellaneous errors.

• Total Counts—Total error count for each type of error.

• Avg. Error Rate (Per Sec)—The calculated average error rate per second for each error type over the 
duration of the data range that you chose.

Note You can sort the contents of the columns in ascending or descending order by clicking the column 
heading.
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Displaying Error Statistics
You can view error data for a shorthaul or backhaul interface in the MWTM: 

• Web interface by selecting an interface in the navigation tree and clicking the Shorthaul Errors or 
Errors tab in the content area.

• Client by right-clicking an interface in the navigation tree and clicking Error History.

Note If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM 
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible 
IOS software, from the MWTM:

• Web interface, choose Administrative > IPRAN OS README.

• Client interface, choose View > MWTM Web Links > Administrative; then click IPRAN OS 
README.

You view error data for a shorthaul or backhaul interface by selecting the interface in the navigation tree 
and clicking the Errors tab in the content area. The Errors tab shows total error counts and average error 
rates in table and graph format. 

This section provides information about:

• Displaying Shorthaul Error Statistics, page 11-32

• Displaying Backhaul Error Statistics, page 11-33

Expand to Full 
Screen

If Output Type is Graph, text link that shows a graph in a new, full-screen window for easier viewing.

Bits/Sec or 
Bytes/Sec

If Output Type is Graph, primary Y-axis label (left side of graph) that shows traffic rate in bits per second. 
The Y axis automatically scales to the User Bandwidth.

If no data exists between any two data points, the graph displays a color-coded vertical bar to show the 
period for which no data is available.

% Utilization If Output Type is Graph, secondary Y-axis label (right side of graph) that shows the backhaul utilization 
as a percentage of the User Bandwidth. The graph background has horizontal bars that are color-coded to 
indicate these thresholds:

• Overloaded—Top portion of graph.

• Warning—Middle portion of graph.

• Acceptable—Bottom portion of graph.

For definitions of these thresholds, see the “Threshold Information (RAN-O Only)” section on page 8-38.

Note If the % Utilization exceeds 100%, see Why does my backhaul graph show greater than 100% for 
transmit traffic?, page C-25.

Time X-axis label that shows a user-specified, historical time scale and the server time zone.

Legend Color-coded legend that shows labels for traffic and error rates.

GUI Elements Description
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Displaying Shorthaul Error Statistics

The Shorthaul Errors tab for a shorthaul interface shows a single table and a graph that shows the error 
rates and counts for different types of GSM-Abis and UMTS-Iub errors. 

The Shorthaul Errors tab for a shorthaul interface contains: 

GUI Elements Description

Toolbar Provides functions to select report type, duration, and output type. See the “Using the Toolbar” section 
on page 11-6.

Type Report Type. If you choose an Error Summary report, the table and graph display a comprehensive 
summary of total error counts and average error rates for protocol, missed-packet, and miscellaneous 
errors for the chosen shorthaul. You can choose from 15-minute, hourly, or daily error summary reports. 
Statistics appear in table and graph format. 

If you choose an error report that is not a summary report, the table and graph displays protocol, missed 
packet, or miscellaneous errors for the shorthaul interface. You can choose from 15-minute, hourly, or 
daily error reports. Statistics appear in table and graph format.

For definitions of these error types, see:

• Protocol Failures, page 8-112

• Miscellaneous, page 8-113

• Missed Packets, page 8-114

Table Note Different tables and column headings appear depending on the report Type and Output Type 
selections.

If Output Type is Graph, a table appears with these columns:

• Data Type—Category of error for which statistics are gathered. Types include protocol, missed 
packets, and miscellaneous errors.

• Total Counts—Total error count for each type of error.

• Avg. Error Rate (Per Sec)—The calculated average error rate per second for each error type over 
the duration of the data range that you chose.

Note If the value is N/A, that means no data is available.

Depending on the report Type selection, if the Output Type is Table or CSV, a table appears with 
multiple columns showing various error types and their counts. For definitions of these error types, see 
the:

• Protocol Failures, page 8-112

• Miscellaneous, page 8-113

• Missed Packets, page 8-114

Note You can sort the contents of the columns in ascending or descending order by clicking the 
column heading.

Expand to Full 
Screen

If Output Type is Graph, this text link displays a graph in a new, full-screen window for easier viewing.

Error Counts If Output Type is Graph, Y-axis label on left side of graph that shows traffic rate in bits per second. 

Note If no data exists between any two data points, the graph displays a color-coded vertical bar to 
show the period for which no data is available.
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Displaying Backhaul Error Statistics

The Errors tab for a RAN backhaul interface shows a single table and a graph that shows the error rates 
and counts for different interfaces belonging to the backhaul. 

The Errors tab for a backhaul interface contains: 

Generating RAN Data Export Files
You can easily generate historical reports for RAN backhauls and shorthauls in the web interface. You 
can then export this data to a report with comma-separated values (CSV file). You can save this file to 
disk or open it with an application that you choose (for example, Microsoft Excel). 

Time If Output Type is Graph, X-axis label that shows a user-specified, historical time scale and the server 
time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for traffic and error rates.

GUI Elements Description

GUI Elements Description

Toolbar Provides functions to select a report type, duration, output type, and the Graph Series Editor. See the 
“Using the Toolbar” section on page 11-6.

Table Note Different tables and column headings appear depending on the report Type and Output Type 
selections.

If Output Type is Graph, a table appears with these columns:

• Data Type—Category of error for which statistics are gathered. Types include optimization, missed 
packets, and miscellaneous errors.

• Total Counts—Total error count for each type of error.

• Avg. Error Rate (Per Sec)—The calculated average error rate per second for each error type over 
the duration of the data range that you chose.

Note If the value is N/A, that means no data is available.

If Output Type is Table, a table appears with columns for total error counts for various error types (for 
example, total GSM-Abis errors).

Note You can sort the contents of the columns in ascending or descending order by clicking the 
column heading.

Expand to Full 
Screen

If Output Type is Graph, text link that shows a graph in a new, full-screen window for easier viewing.

Error Counts If Output Type is Graph, Y-axis label on left side of graph that shows traffic rate in bits per second. 

Time If Output Type is Graph, X-axis label that shows a user-specified, historical time scale and the server 
time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for traffic and error rates (for example, 
Total Errors UMTS-Iub).
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To export RAN data:

Step 1 Select a RAN backhaul or shorthaul in the navigation tree of the web interface.

Step 2 Click the Performance or Errors tab in the right pane.

Step 3 Generate a report.

Step 4 Click the Export the report as a CSV file icon . 

Displaying CSG2 Real-Time Statistics
The MWTM enables you to display real-time statistics for CSG2 nodes in the MWTM web interface. To 
display real-time statistics, select the node in the navigation tree and click the Statistics tab. The 
following options appear under the Type drop-down menu:

• Global Statistics, page 11-34

• CSG2 Protocol, page 11-40

• Gx Global Statistics, page 11-41

• Gx Policy Preload, page 11-43

• Gx Policy Preload Ext, page 11-44

• Gx PCRF Method List Message, page 11-46

• Gx PCRF Method List Message Error, page 11-47

Global Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Global Statistics table, choose this option from the Type drop-down menu. The GUI displays 
the following categories:

• Global Statistics, page 11-35

• Load Statistics, page 11-35

• BMA Statistics, page 11-38

• Quota Server Statistics, page 11-39

• User Database Statistics, page 11-40
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Global Statistics

The Global Statistics pane contains: 

Load Statistics

Load statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or later. 

The Load Statistics pane contains: 

Field Description

User Current The total number of users with one or more active sessions on the system.

Session Current The total number of sessions on the system. A session corresponds to a transmission control 
protocol (TCP) or user datagram protocol (UDP) flow.

User High Water The highest number of active users reported by the User Current field since its last reset.

Session High Water The highest number of active sessions reported by the Session Current field since its last reset.

User License

The following statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or later. 

GTP BMA Rejected Number of messages received from all the Billing Mediation Agents (BMAs) with reject cause 
code.

GTP BMA Dropped Total Number of messages dropped destined for any of the BMAs

GTP BMA Retransmit Number of messages retransmitted to all BMAs.

GTP QuotaMgr Rejected Number of messages received from all the Quota Managers with reject cause code. 

GTP QuotaMgr Dropped Total Number of messages dropped destined for any of the Quota Managers.

GTP QuotaMgr 
Retransmit

Number of messages retransmitted to all the Quota Managers.

Description

Statistics Type Column Defines the type of statistics for each row: 

• Radius Start Requests

• Session Create Requests

• BMA Messages

• Messages to Quota Server

• User Database Requests
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Radius Start 
Requests

Allowed Number of outgoing Radius Start requests allowed. 

Allowed Rate Number of outgoing Radius Start requests allowed per second.

Allowed Rate 
High Water

The highest number of outgoing Radius Start requests allowed per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for Radius Start requests in the (Inter Processor 
Communication) IPC queue. 

Denied Number of outgoing Radius Start requests denied.

Denial Rate Number of outgoing Radius Start requests denied per second.

Denial Rate
High Water

The highest number of outgoing Radius Start requests denied per second. 

Session Create 
Requests

Allowed Number of outgoing Session Create Requests allowed. 

Allowed Rate Number of outgoing Session Create Requests allowed per second.

Allowed Rate 
High Water

The highest number of outgoing Session Create Requests allowed per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for Session Create Requests in the IPC queue. 

Denied Number of outgoing Session Create Requests denied.

Denial Rate Number of outgoing Session Create Requests denied per second.

Denial Rate
High Water

The highest number of outgoing Session Create Requests denied per second. 

BMA Messages Allowed Number of outgoing BMA messages allowed. 

Allowed Rate Number of outgoing BMA messages allowed per second.

Allowed Rate 
High Water

The highest number of outgoing BMA messages allowed per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for BMA messages in the IPC queue. 

Denied Number of outgoing BMA messages denied.

Denial Rate Number of outgoing BMA messages denied per second.

Denial Rate
High Water

The highest number of outgoing BMA messages denied per second. 

Messages to Quota 
Server

Allowed Number of outgoing messages to Quota Manager allowed. 

Allowed Rate Number of outgoing messages to Quota Manager allowed per second.

Allowed Rate 
High Water

The highest number of outgoing messages to Quota Manager allowed per 
second. 

IPC Queue Depth 
Tolerance

Maximum queue depth for messages to Quota Manager in the IPC queue. 

Denied Number of outgoing messages to Quota Manager denied.

Denial Rate Number of outgoing messages to Quota Manager denied per second.

Denial Rate
High Water

The highest number of outgoing messages to Quota Manager denied per second. 

Description
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BMA Statistics

The Billing Mediation Agent (BMA) Statistics pane contains: 

User Database 
Requests

Allowed Number of outgoing User Database requests allowed. 

Allowed Rate Number of outgoing User Database requests allowed per second.

Allowed Rate 
High Water

The highest number of outgoing User Database requests allowed per second.

IPC Queue Depth 
Tolerance

Maximum queue depth for User Database requests in the IPC queue. 

Denied Number of outgoing User Database requests denied.

Denial Rate Number of outgoing User Database requests denied per second.

Denial Rate
High Water

The highest number of outgoing User Database requests denied per second. 

Description

Column Description

Server Name of the BMA server.

Port The UDP port of the BMA.

VRF Name Name of the virtual routing and forwarding (VRF) over which communication with BMA occurs. If no 
VRF is specified, the global routing table is used.

State The state of the BMA. Possible states include:

• Standby—The server is prepared to become active.

• Failed—The server has failed to respond to requests.

• Active—The server has been activated to receive requests.

• Echowait—An echo request to this billing mediation agent is waiting for a response.

• Nawait—A node-alive request to this billing mediation agent is waiting for a response.

• Suspended—The server has received a stop request from the operator.

Lost Records Total number of lost records since system initialization or the last time the counter wrapped.

Total Sent Total number of records sent to the billing mediation agent.

Failed Acks Number of acknowledgments received from the billing mediation agent for which there are no 
outstanding requests.

Outstanding Current number of messages waiting to be acknowledged. An arrow icon indicates the trend (up or 
down) since the last poll.

Outstanding High 
Water

The highest number of messages waiting for acknowledgements as reported by the Outstanding field 
since its last reset. 

Bad Records Number of bad records received. These are records in which an error was detected while attempting to 
decode the contents.

Retransmits Number of messages retransmitted to the billing mediation agent.

Sent Rate Rate at which records are sent to the billing mediation agent.

The following statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or later. 
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Quota Server Statistics

The Quota Server Statistics pane contains: 

Rate Interval The duration of time interval in Packet Rate and Ack Rate.

Packet Rate Number of packets sent to the BMA per second calculated over the interval indicated by Rate Interval.

Ack Rate Number of acknowledgments received from the BMA per second calculated over the interval indicated 
by Rate Interval.

Column Description

Column Description

Server Name of the quota server.

Port The UDP port of the quota server.

VRF Name Name of the Virtual Routing and Forwarding (VRF) over which communication with the quota server 
occurs. If no VRF is specified, the global routing table is used.

State The state of the quota manager. Possible states include:

• Standby—The quota manager is prepared to become active.

• Failed—The quota manager has failed to respond to requests.

• Active—The quota manager has been activated to receive requests.

• Echowait—An echo request to this quota manager is waiting for a response.

• Nawait—A node-alive request to this quota manager is waiting for a response.

• Suspended—The quota manager has received a stop request from the operator.

Lost Records Total number of lost records since system initialization or the last time the counter wrapped.

Total Sent Total number of records sent to the quota server.

Failed Acks Number of acknowledgments received from the quota server for which there are no outstanding 
requests.

Outstanding Current number of messages waiting to be acknowledged. An arrow icon indicates the trend (up or 
down) since the last poll.

Outstanding High 
Water

The highest number of messages waiting for acknowledgements as reported by the Outstanding field 
since its last reset. 

Bad Records Number of bad records received. These are records in which an error was detected while attempting to 
decode the contents.

Retransmits Number of messages retransmitted to the quota manager.

Sent Rate Rate at which records are sent to the quota server.

The following statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or later. 

Rate Interval The duration of time interval in Packet Rate and Ack Rate. 

Packet Rate Number of packets sent to the Quota Manager per second calculated over the interval indicated by Rate 
Interval.

Ack Rate Number of acknowledgments received from the Quota Manager per second calculated over the interval 
indicated by Rate Interval. 
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User Database Statistics

The user database is a service that translates a client IP address into a user identifier. The User Database 
Statistics pane contains: 

CSG2 Protocol

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the CSG2 Protocol statistics, choose this option from the Type drop-down menu. The GUI 
displays:

Column Description

Server Name of the user database server.

Port The listening UDP port of the server.

VRF Name Name of the VRF over which communication with user data server occurs. If no VRF is specified, the 
global routing table is used.

State State of the user database. Possible values include:

Reset—State before the database is determined to be active.

Active—The database is available and processing requests.

Failed—The database has failed and is not processing requests.

Requests Number of user database requests.

User Identifiers 
Returned

Number of user identifiers returned.

Requests Resent Number of user database requests resent.

Request Timeouts Number of user database requests that have timed out.

Request Errors Number of errors returned on user database requests.

Requests Rate Rate of user database requests.

User Identifiers 
Returned Rate

Rate at which user identifiers are returned.

Column Description

Inspection Method Type of inspection method used to identify the protocol.

Protocol Protocol name used in the configuration of the entity which provides the content services.

Transactions • Count—Total number of transactions occurred in the network.

• Rate—Number of transactions occurred in the network per second.

• Peak—The highest number of transactions occurred in the network per second.

Subscriber Send 
Packets

• Count—Total number of outgoing subscriber packets.

• Rate—Number of outgoing subscriber packets per second.

• Peak—The highest number of outgoing subscriber packets per second.
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Gx Global Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Gx Global statistics, choose this option from the Type drop-down menu. The GUI displays 
the following categories:

• Global Message Statistics, page 11-41

• Global Message Error Statistics, page 11-42

Global Message Statistics

The Global Message Statistics pane contains:

Subscriber Send 
Bits

• Count—Total number of outgoing subscriber bits.

• Rate—Number of outgoing subscriber bits per second.

• Peak—The highest number of outgoing subscriber bits per second.

Network Send 
Packets

• Count—Total number of outgoing network packets.

• Rate—Number of outgoing network packets per second.

• Peak—The highest number of outgoing network packets per second.

Network Send Bits • Count—Total number of outgoing network bits.

• Rate—Number of outgoing network bits per second.

• Peak—The highest number of outgoing network bits per second.

Column Description

Column Description

Active Sessions Total number of active sessions.

Credit Control 
Request Initial 
Messages Sent

Total number of CCR-Initial messages sent.

Credit Control 
Request Initial 
Messages Sent Rate

Rate at which CCR-Initial messages are sent.

Credit Control 
Request Update 
Messages Sent

Total number of CCR-Update messages sent.

Credit Control 
Request Update 
Messages Sent Rate

Rate at which the CCR-Update messages are sent.

Credit Control 
Request Final 
Messages Sent

Total number of CCR-Final messages sent.
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Global Message Error Statistics

The Global Message Error Statistics pane contains:

Credit Control 
Request Final 
Messages Sent Rate

Rate at which the CCR-Final messages are sent.

Credit Control 
Answer Messages 
Received

Total number of CCA messages received.

Credit Control 
Answer Messages 
Received Rate

Rate at which the CCA messages are received.

Reauthorization 
Request Messages 
Received

Total number of RAR messages received.

Reauthorization 
Request Messages 
Received Rate

Rate at which the RAR messages are sent.

Reauthorization 
Answer Messages 
Sent

Total number of RAA messages sent.

Reauthorization 
Answer Messages 
Sent Rate

Rate at which the RAA messages are sent.

Column Description

Column Description

Credit Control 
Response Failures

Number of failures to send CCR.

Invalid Message 
Type Errors

Total number of invalid message type errors.

Duplicate Request 
Errors

Total number of duplicate request type errors.

Credit Control 
Answer Errors

Total number of errors occurred in CCA.

Reauthorization 
Answer Failures

Number of failures to send RAA.

Reauthorization 
Response Errors

Total number of errors occurred in RAR.

Invalid Request 
Type Errors

Number of errors due to invalid request type.

Invalid Request 
Number Errors

Number of errors due to invalid request number.
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Gx Policy Preload

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Gx Policy Preload statistics, choose this option from the Type drop-down menu. The GUI 
displays the following categories:

• Policy Preload Statistics, page 11-43

• Policy Preload Error Statistics, page 11-43

Policy Preload Statistics

The Policy Preload Statistics pane contains:

Policy Preload Error Statistics

The Policy Preload Error Statistics pane contains:

Invalid Request 
Status Errors

Number of errors due to invalid request status.

Invalid Session ID 
Errors

Number of times the session id received does not exist or when the session id associated with request 
is not the same as the one received.

Column Description

Column Description

PCEF Initiated 
Preloading

Number of PCEF initiated preloading.

PCRF Initiated 
Preloading

Number of PCRF initiated preloading.

Policy Preload 
Requests

Number of Policy Preload requests.

Policy Preload 
Responses

Number of Policy Preload responses.

Global Policy Push 
Count

Number of Global Policy Push.

Global Policy Push 
Acknowledgement

Number of Global Policy Push Acknowledgement.

Column Description

Preload Data 
Inconsistent

Number of times the preload data is inconsistent.

Attribute Value 
Pairs Missing

Number of times the mandatory AVPs (Attribute Value Pairs) are missing.
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Gx Policy Preload Ext

Note For toolbar details, see Using the Toolbar, page 11-6.

Wrong Order 
Failures

Number of failures due to wrong order.

Enforcement 
Failures

Number of failures to enforce.

Static configuration 
Conflicts

Number of conflicts with static config.

Credit Control 
Request Failures

Number of times failed to CCR (Credit Control Request).

Invalid Message 
Type Errors

Number of invalid message type errors.

Credit Control 
Answer Errors

Total number of errors occurred in CCA (Credit Control Answer).

Reauthorization 
Answer Failures

Number of times failed to send RAA (Re-Authorization Answer).

Reauthorization 
Response Errors

Total number of errors occurred in RAR (Re-Authorization Request).

Invalid Request 
Type Errors

Number of invalid req-type errors.

Invalid Request 
Number Errors

Number of invalid req-num errors.

Invalid Request 
Status Errors

Number of invalid req-status errors.

Invalid Session ID 
Errors

Number of times the session id received does not exist or when the session id associated with request 
is not the same as the one received.

Preload Timeout 
Errors

Number of times the preload timeout occurs.

Column Description
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To view the Gx Policy Preload Ext statistics, choose this option from the Type drop-down menu. The 
GUI displays:

Field or Column Description

Delete Failed • Service Contents—Number of times deletion of service contents has failed during preload.

• Accounting Policy Maps—Number of times deletion of accounting policy-maps has failed during 
preload.

• Billing Services—Number of times deletion of billing services has failed during preload.

• Content Policies—Number of times deletion of content policies has failed during preload.

• Billing Plans—Number of times deletion of billing plans has failed during preload.

Deleted • Service Contents—Number of service contents deleted during preload.

• Accounting Policy Maps—Number of accounting policy-maps deleted during preload.

• Billing Services—Number of billing services deleted during preload.

• Content Policies—Number of content policies deleted during preload.

• Billing Plans—Number of billing plans deleted during preload.

Insert Failed • Service Contents—Number of times insertion of service contents has failed during preload.

• Accounting Policy Maps—Number of times insertion of accounting policy-maps has failed during 
preload.

• Billing Services—Number of times insertion of billing services has failed during preload.

• Content Policies—Number of times insertion of content policies has failed during preload.

• Billing Plans—Number of times insertion of billing plans has failed during preload.

Inserted • Service Contents—Number of service contents inserted during preload.

• Accounting Policy Maps—Number of accounting policy-maps inserted during preload.

• Billing Services—Number of billing services inserted during preload.

• Content Policies—Number of content policies inserted during preload.

• Billing Plans—Number of billing plans inserted during preload.
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Gx PCRF Method List Message

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Gx PCRF Method List Message statistics, choose this option from the Type drop-down 
menu. The GUI displays:

Roll Back Failed • Service Contents—Number of times rollback has failed on insertion or deletion of service contents 
during preload.

• Accounting Policy Maps—Number of times rollback has failed on insertion or deletion of 
accounting policy-maps during preload.

• Billing Services—Number of times rollback has failed on insertion or deletion of billing services 
during preload.

• Content Policies—Number of times rollback has failed on insertion or deletion of content policies 
during preload.

• Billing Plans—Number of times rollback has failed on insertion or deletion of billing plans during 
preload.

Rolled Back • Service Contents—Number of times the rollback is successful on insertion or deletion of service 
contents during preload.

• Accounting Policy Maps—Number of times the rollback is successful on insertion or deletion of 
accounting policy-maps during preload.

• Billing Services—Number of times the rollback is successful on insertion or deletion of billing 
services during preload.

• Content Policies—Number of times the rollback is successful on insertion or deletion of content 
policies during preload.

• Billing Plans—Number of times the rollback is successful on insertion or deletion of billing plans 
during preload.

Field or Column Description

Column Description

Method List Name Method list name.

Credit Control 
Request Initial 
Messages Sent

• Count—Total number of CCR-Initial messages sent.

• Rate—Rate at which CCR-Initial messages are sent.

Credit Control 
Request Update 
Messages Sent

• Count—Total number of CCR-Update messages sent.

• Rate—Rate at which the CCR-Update messages are sent.

Credit Control 
Request Final 
Messages Sent

• Count—Total number of CCR-Final messages sent.

• Rate—Rate at which the CCR-Final messages are sent.

Credit Control 
Answer Messages 
Received

• Count—Total number of CCA messages received.

• Rate—Rate at which the CCA messages are received.
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Gx PCRF Method List Message Error

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Gx PCRF Method List Message Error statistics, choose this option from the Type drop-down 
menu.

The GUI displays:

Reauthorization 
Request Messages 
Received

• Count—Total number of RAR messages received.

• Rate—Rate at which the RAR messages are sent.

Reauthorization 
Answer Messages 
Sent

• Count—Total number of RAA messages sent.

• Rate—Rate at which the RAA messages are sent.

Column Description

Column Description

Method List Name Method list name.

PCRF Reboots Number of times PCRF reboots.

Invalid Message 
Type Errors

Total number of invalid message type errors.

Duplicate Request 
Errors

Total number of duplicate request type errors.

Credit Control 
Response Failures

Number of failures to send CCR.

Credit Control 
Answer Errors

Total number of errors occurred in CCA.

Reauthorization 
Answer Failures

Number of failures to send RAA.

Reauthorization 
Response Errors

Total number of errors occurred in RAR.

Invalid Request 
Type Errors

Number of errors due to invalid request type.

Invalid Request 
Number Errors

Number of errors due to invalid request number.

Invalid Request 
Status Errors

Number of errors due to invalid request status.

Invalid Session ID 
Errors

Number of times the session id received does not exist or when the session id associated with request 
is not the same as the one received.
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Displaying BWG Real-Time Statistics
The MWTM enables you to display real-time statistics for Broadband Wireless Gateway (BWG) nodes 
in the MWTM web interface. To display BWG real-time statistics, select a BWG node in the navigation 
tree and click the Statistics tab. The following subtabs appear:

• Global, page 11-48

• Paths, page 11-56

• User Groups, page 11-57

Global
The Global subtab shows global statistics for BWG nodes and contains:

• Status, page 11-48

• Creation and Deletion Statistics, page 11-49

• Miscellaneous Statistics, page 11-50

• Signaling Packet Statistics, page 11-51

• DHCP Packet Statistics, page 11-51

• Handoff Statistics, page 11-52

• Data Packet Statistics, page 11-53

• Dropped Packet Statistics, page 11-54

• Profile Statistics, page 11-55

• Rejected Statistics, page 11-56

Note For toolbar details, see Using the Toolbar, page 11-6.

Status

The Status pane shows:

Field Description

Version Software version of the BWG.

Description Description of the physical instance of the BWG.

Operational Status Current operational state of the BWG.

Session 
Redundancy Status

Indicates whether session redundancy is enabled or disabled.
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Creation and Deletion Statistics

The Creation and Deletion Statistics pane shows:

Field Description

Base Stations • Maximum—Maximum number of base stations that can be concurrently 
supported by this BWG.

• Current—Current number of signaling paths to all base stations. One 
signaling path is created between the BWG and each base station, so the 
current number of signaling paths is equal to the number of base stations 
currently connected to the BWG. 

• Created Count—Total number of signaling paths created on this BWG which 
include active and past signaling paths.

• Created Rate—Rate at which signaling paths are created.

• Deleted Count—Total number of signaling paths deleted on this BWG.

• Deleted Rate—Rate at which signaling paths are deleted.

Data Paths • Maximum—N/A

• Current—Current number of data paths to all base stations.

• Created Count—Total number of data paths created on this BWG which 
include active and past data paths.

• Created Rate—Rate at which data paths are created.

• Deleted Count—Total number of data paths deleted on this BWG.

• Deleted Rate—Rate at which data paths are deleted.

Subscribers • Maximum—Maximum number of subscribers that can be concurrently 
supported by this BWG.

• Current—Number of subscribers currently connected to this BWG.

• Created Count—Total number of subscribers created on this BWG which 
includes active and past subscribers

• Created Rate—Rate at which subscribers are created.

• Deleted Count—Total number of subscribers deleted on this BWG.

• Deleted Rate—Rate at which subscribers are deleted.

Sessions • Maximum—N/A

• Current—Number of sessions currently active on this BWG.

• Created Count—Total number of sessions created on this BWG which 
include active and past sessions.

• Created Rate—Rate at which sessions are created.

• Deleted Count—Total number of sessions deleted on this BWG.

• Deleted Rate—Rate at which sessions are deleted.
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Miscellaneous Statistics

The Miscellaneous Statistics pane shows:

Flows • Maximum—N/A

• Current—Current number of flows for all sessions active on this BWG.

• Created Count—Total number of flows created on this BWG which include 
active and past flows.

• Created Rate—Rate at which flows are created.

• Deleted Count—Total number of flows deleted on this BWG.

• Deleted Rate—Rate at which flows are deleted.

Hosts • Maximum—N/A

• Current—Current number of hosts connected to this BWG.

• Created Count—Total number of hosts created on this BWG which include 
active and past hosts.

• Created Rate—Rate at which hosts are created.

• Deleted Count—Total number of hosts deleted on this BWG.

• Deleted Rate—Rate at which hosts are deleted.

Field Description

Field Description

Framed Routes Indicates the current number of unique framed routes downloaded from AAA and 
inserted into the IP routing table on a gateway.

Framed Router 
Subscribers

Indicates the number of subscribers using framed routes.

Auto-Provisioned 
Sessions

Indicates the number of auto-provisioned sessions on gateway.

Redirected 
Sessions

Indicates the number of sessions with all uplink IP packets redirected by the 
gateway.

Networks Behind 
Mobile Stations

Indicates the number of networks behind mobile stations. 

Aged Out Hosts • Count—Indicates the number of idle static hosts aged out.

• Rate—Rate at which idle static hosts are aged out.
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Signaling Packet Statistics

The Signaling Packet Statistics pane shows:

DHCP Packet Statistics

The DHCP Packet Statistics pane shows:

Field Description

Pending • Count—Total number of signaling packets currently pending on this BWG

Processed • Count—Total number of signaling packets processed by this BWG.

• Rate—Rate at which signaling packets are processed.

Requeued • Count—Total number of signaling packets that were requeued on this BWG.

• Rate—Rate at which signaling packets are requeued.

Congestion Drops • Count—Number of signaling packets dropped when too many signaling 
packets are queued. The current queue limit is 1000 packets.

• Rate—Rate at which signaling packets are dropped.

Service Disabled 
Drops

• Count—Number of signaling packets dropped due to disabled service.

• Rate—Rate at which signaling packets are dropped.

Service Not Ready 
Drops

• Count—Number of signaling packets dropped while in non-active state for 
redundant configuration.

• Rate—Rate at which signaling packets are dropped.

Encapsulation 
Errors Drops

• Count—Number of signaling packets dropped due to encapsulation errors.

• Rate—Rate at which signaling packets are dropped.

Disposed Drops • Count—Number of signaling packets disposed by the BWG.

• Rate—Rate at which signaling packets are disposed.

Field Description

Discover • Count—Number of DHCP discover packets.

• Rate—Rate at which DHCP packets are discovered.

Offer • Count—Number of DHCP offer packets.

• Rate—Rate at which DHCP packets are offered.

Request • Count—Number of DHCP request packets.

• Rate—Rate at which DHCP packets are requested.

Decline • Count—Number of DHCP decline packets.

• Rate—Rate at which DHCP packets are declined.

Ack • Count—Number of DHCP acknowledged packets.

• Rate—Rate at which DHCP packets are acknowledged.

Nak • Count—Number of DHCP negatively acknowledged packets.

• Rate—Rate at which DHCP packets are negatively acknowledged.
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Handoff Statistics

The Handoff Statistics pane shows:

Release • Count—Number of DHCP release packets.

• Rate—Rate at which DHCP packets are released.

Inform • Count—Number of DHCP inform packets.

• Rate—Rate at which DHCP packets are informed.

Lease Query • Count—Number of DHCP lease query packets.

• Rate—Rate at which DHCP packets are lease queried.

Unknown • Count—Number of DHCP unknown packets.

• Rate—Rate at which DHCP packets are unknown.

Field Description

Field Description

Successful 
Handoffs

• Count—Number of successful session handoffs between Base Stations.

• Rate—Rate at which successful session handoffs occur.

Failed Handoffs • Count—Number of failed session handoffs between Base Stations.

• Rate—Rate at which failed session handoffs occur.

Successful CMAC 
Key Updates

• Count—Number of successful CMAC Key count updates related to handoff 
between base stations.

• Rate—Rate at which successful CMAC Key count updates are received.

Failed CMAC Key 
Updates

• Count—Number of failed CMAC Key count updates related to handoff 
between base stations.

• Rate—Rate at which failed CMAC Key count updates are received.

Successful Security 
Key Updates

• Count—Number of successful security key updates during handoff between 
base stations.

• Rate—Rate at which successful security key updates occur.

Failed Security Key 
Updates

• Count—Number of failed security key updates during handoff between base 
stations.

• Rate—Rate at which failed security key updates occur.
11-51
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.3

OL-22496-01



 

Chapter 11      Accessing Data from the Web Interface
  Displaying BWG Real-Time Statistics
Data Packet Statistics

The Data Packet Statistics pane shows:

Field Description

Received IP 
Packets

• Count—Number of data packets received by the BWG.

• Rate—Rate at which data packets are received by the BWG.

Received IP Bits • Count—Number of data bits received by the BWG.

• Rate—Rate at which data bits are received by the BWG.

Sent IP Packets • Count—Number of data packets sent by the BWG.

• Rate—Rate at which data packets are sent by the BWG.

Sent IP Bits • Count—Number of data bits sent by the BWG.

• Rate—Rate at which data bits are sent by the BWG.

Redirected IP 
Packets

• Count—Number of IP packets redirected by the BWG. 

• Rate—Rate at which IP packets are redirected by the BWG. 

Redirected IP Bits • Count—Number of IP bits redirected by the BWG. 

• Rate—Rate at which IP bits are redirected by the BWG. 

Received Ethernet 
Packets

• Count—Number of ethernet packets received by the BWG. 

• Rate—Rate at which IP packets are redirected by the BWG.

Received Ethernet 
Bits

• Count—Number of ethernet bits received by the BWG. 

• Rate—Rate at which ethernet bits are received by the BWG.

Sent Ethernet 
Packets

• Count—Number of ethernet packets sent by the BWG. 

• Rate—Rate at which ethernet packets are sent by the BWG. 

Sent Ethernet Bits • Count—Number of ethernet bits sent by the BWG. 

• Rate—Rate at which ethernet bits are sent by the BWG. 

Redirected Ethernet 
Packets

• Count—Number of ethernet packets redirected by the BWG. 

• Rate—Rate at which ethernet packets are redirected by the BWG.

Redirected Ethernet 
Bits 

• Count—Number of ethernet bits redirected by the BWG.

• Rate—Rate at which ethernet bits are redirected by the BWG.

Punted Data 
Packets

• Count—Number data packets punted from the cef path to the process path. 

• Rate—Rate at which packets are punted from the cef path to the process 
path. 
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Dropped Packet Statistics

The Dropped Packet Statistics pane shows:

Field Description

Encapsulation 
Errors Drops

• Count—Number of data packets dropped due to encapsulation errors.

• Rate—Rate at which data packets are dropped.

Invalid Address 
Drops

• Count—Number of data packets dropped due to invalid IP address.

• Rate—Rate at which data packets are dropped.

Service Disabled 
Drops

• Count—Number of data packets dropped due to disabled service. 

• Rate—Rate at which data packets are dropped.

Invalid Protocol 
Type Drops

• Count—Number of data packets dropped due to invalid protocol types.

• Rate—Rate at which data packets are dropped.

Length Error Drops • Count—Number of data packets dropped due to IP packet length errors.

• Rate—Rate at which data packets are dropped.

Absent Key Drops • Count—Number of data packets dropped due to GRE key errors.

• Rate—Rate at which data packets are dropped.

Flow Not Found 
Drops

• Count—Number of data packets dropped due to flow not found errors.

• Rate—Rate at which data packets are dropped.

Flow Path Not 
Found Drops

• Count—Number of data packets dropped due to flow path not found errors.

• Rate—Rate at which data packets are dropped due to flow path not found 
errors. 

Flow Path Invalid 
Source Drops

• Count—Number of data packets dropped due to invalid source path address 
errors in the GRE header.

• Rate—Rate at which data packets are dropped due to invalid source path 
address errors in the GRE header.

Session Not Found 
Drops

• Count—Number of data packets dropped due to session not found errors for 
the GRE key.

• Rate—Rate at which data packets are dropped due to session not found 
errors. 

Subscriber Not 
Found Drops

• Count—Number of data packets dropped due to subscriber not found errors 
for the GRE key.

• Rate—Rate at which data packets are dropped due to subscriber not found 
errors.

Checksum Error 
Drops

• Count—Number of data packets dropped due to checksum errors.

• Rate—Rate at which data packets are dropped due to checksum errors.

Ingress Filtering 
Drops

• Count—Number of data packets dropped due to subscriber invalid source IP 
address errors.

• Rate—Rate at which data packets are dropped due to invalid source IP 
address errors. 
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Profile Statistics

The Profile Statistics pane shows:

Sequence Number 
Error Drops

• Count—Number of data packets dropped due to sequence number errors.

• Rate—Rate at which data packets are dropped due to sequence number 
errors.

Fragmented Drops • Count—Number of data packets dropped due to fragmented packet errors.

• Rate—Rate at which data packets dropped due to fragmented packet errors. 

Static IP Host 
Creation Failure 
Drops

• Count—Number of packets, such as upstream ARP and upstream data 
packets, dropped due to failure in creation of Static IP Host.

• Rate—Rate at which data packets are dropped due to failure in creation of 
Static IP Host. 

L2 Multicast and 
Broadcast Drops

• Number of L2 multicast and broadcast data packets other than ARP and 
DHCP dropped by BWG. 

• Rate—Rate at which L2 multicast and broadcast data packets are dropped. 

Throttled Path Punt 
Drops

• Count—Number of data packets dropped due to throttling of punts.

• Rate—Rate at which L2 multicast and broadcast data packets are dropped. 

Learned Static 
Hosts Drops

• Count—Number of data packets dropped due to BWG learning about static 
hosts from upstream data packets.

• Rate—Rate at which data packets are dropped due to BWG learning about 
static hosts from upstream data packets.

Field Description

Field Description

Service Flow 
Profile Not Found

• Count—Number of service flow creation errors due to an unconfigured 
service flow profile. 

• Rate—Rate at which creation errors are received.

QOS Profile Not 
Found

• Count—Number of service flow creation errors due to an unconfigured 
service flow QoS profile.

• Rate—Rate at which creation errors are received.

Classifier Profile 
Not Found

• Count—Number of service flow creation errors due to an unconfigured 
service flow packet classifier profile.

• Rate—Rate at which service flow creation errors occur due to an 
unconfigured service flow packet classifier profile.

SLA Profile Not 
Found

• Count—Number number of session creation failures due to configuration 
error in Service Level Agreement (SLA) profile on BWG. 

• Rate—Rate at which session creation failures occur due to configuration 
error in Service Level Agreement (SLA) profile on BWG.
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Rejected Statistics

The Rejected Statistics pane shows:

Paths

Note For toolbar details, see Using the Toolbar, page 11-6.

The Paths subtab shows information and statistics about each base station and contains:

Field Description

Rejected Base 
Station Paths 

• Count—Number of paths rejected because they exceeded the maximum 
number of base stations allowed to connect to this BWG.

• Rate—Rate at which paths are rejected because they exceeded the maximum 
number of base stations allowed to connect to this BWG.

Unapproved Base 
Station Sessions

• Count—Number of session creation and/or session handoffs rejected 
because the requesting base station is not approved for it.

• Rate—Rate at which created sessions and/or session handoffs are rejected 
because the base station is not approved for it. 

Rejected 
Subscriber Sessions

• Count—Number of sessions rejected due to exceeding the maximum number 
of allowed subscribers.

• Rate—Rate at which sessions that were rejected due to exceeding the 
maximum number of allowed subscribers. 

Rejected Session 
Flows

• Count—Number of flows that were rejected due to exceeding the        
maximum number of flows allowed per session.

• Rate—Rate at which flows were rejected due to exceeding the maximum 
number of flows allowed per session.

Session Deleted by 
the Gateway

• Count—Number of sessions deleted by the BWG.

• Rate—Rate at which sessions were deleted by the BWG. 

Rejected Hosts 
Open Requests

• Count—Number of hosts open requests rejected.

• Rate—Rate at which hosts open requests are rejected. 

Column Description

Remote IP Address Path IP address at the base station side.

Local IP Address Path IP address at the BWG side.

Type Path type, can be signaling or data.

Sessions Number of sessions over the path.

Flows Number of flows over the path.

Sent IP Packets • Count—Total number of IP packets sent over the path.

• Rate—Rate at which IP packets are sent.
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User Groups
The User Groups subtab shows information and statistics for user groups and contains:

• Sessions and Flow Statistics, page 11-57

• Traffic Statistics, page 11-58

Note For toolbar details, see Using the Toolbar, page 11-6.

Sessions and Flow Statistics

The Sessions and Flow Statistics pane shows:

Sent IP Bits • Count—Total number of IP bits sent over the path.

• Rate—Rate at which IP bits are sent.

Received IP 
Packets

• Count—Total number of IP packets received over the path.

• Rate—Rate at which IP packets are received.

Received IP Bits • Count—Total number of IP bits received over the path.

• Rate—Rate at which IP bits are received.

Sent Ethernet 
Packets

• Count—Total number of Ethernet packets sent over the path.

• Rate—Rate at which Ethernet packets are sent.

Sent Ethernet Bits • Count—Total number of Ethernet bits sent over the path.

• Rate—Rate at which Ethernet bits are sent.

Received Ethernet 
Packets

• Count—Total number of Ethernet packets received over the path.

• Rate—Rate at which Ethernet packets are received.

Received Ethernet 
Bits

• Count—Total number of Ethernet bits received over the path.

• Rate—Rate at which Ethernet bits are received.

Column Description

Column Description

Name Domain name identifying a user group.

Service Mode User group service mode.

Current Session 
Count

Total number of active sessions per user group.

Current Flows 
Count

Total number of active flows per user group.

Sessions Created • Count—Total number of sessions created per user group.

• Rate—Rate at which sessions are created.

Sessions Deleted • Count—Total number of sessions deleted per user group.

• Rate—Rate at which sessions are deleted.
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Traffic Statistics

The Traffic Statistics pane shows:

Flows Created • Count—Total number of flows created per user group.

• Rate—Rate at which flows are created.

Flows Deleted • Count—Total number of flows deleted per user group.

• Rate—Rate at which flows are deleted.

Group Overwrites • Count—Number of times this user group has been overwritten by the user 
group received from the AAA server. Users can belong to a particular user 
group at the time of initial entry and the AAA server can recategorize the 
user under a different user group after successful authentication.

• Rate—Rate at which this user group has been overwritten by the user group 
received from the AAA server. 

Column Description

Column Description

Name Domain name identifying a user group.

Service Mode User group service mode.

Sent IP Packets • Count—Total number of IP packets sent over the path.

• Rate—Rate at which IP packets are sent.

Sent IP Bits • Count—Total number of IP bits sent over the path.

• Rate—Rate at which IP bits are sent.

Received IP 
Packets

• Count—Total number of IP packets received over the path.

• Rate—Rate at which IP packets are received.

Received IP Bits • Count—Total number of IP bits received over the path.

• Rate—Rate at which IP bits are received.

Sent Ethernet 
Packets

• Count—Total number of Ethernet packets sent over the path.

• Rate—Rate at which Ethernet packets are sent.

Sent Ethernet Bits • Count—Total number of Ethernet bits sent over the path.

• Rate—Rate at which Ethernet bits are sent.

Received Ethernet 
Packets

• Count—Total number of Ethernet packets received over the path.

• Rate—Rate at which Ethernet packets are received.

Received Ethernet 
Bits

• Count—Total number of Ethernet bits received over the path.

• Rate—Rate at which Ethernet bits are received.

Invalid Source 
Packets

• Count—Number of packets dropped due to invalid source address errors.

• Rate—Rate at which packets are dropped.

Invalid Source Bits • Count—Number of bits dropped due to invalid source address errors.

• Rate—Rate at which bits are dropped.
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Displaying HA Real-Time Statistics
The MWTM enables you to display real-time statistics for Home Agent (HA) nodes in the MWTM web 
interface. To display HA real-time statistics, select a HA node in the navigation tree and click the 
Statistics tab. These subtabs appear:

• Global, page 11-59

• IP Local Pool Config, page 11-61

• IP Local Pool Stats, page 11-61

Global
The Global subtab shows global statistics for HA nodes and contains:

• Registrations Processed by AAA, page 11-59

• Registration Requests, page 11-60

• Standby Synchronization, page 11-60

Note For toolbar details, see Using the Toolbar, page 11-6.

Registrations Processed by AAA

The Registrations Processed by AAA pane shows:

Field Description

Maximum 
Processed in one 
minute

The maximum number of registration requests processed in a minute by the HA. 
It includes only those registration requests which were authenticated by the AAA 
server.

Average time to 
process (msecs)

The average time taken by the home agent to process a registration request. 
Calculations are based on only those registration requests that were authenticated 
by the AAA server.

Authenticated via 
AAA Server

• Count—The total number of registration requests processed by the home 
agent, including only those registration requests that were authenticated by 
the AAA server. 

• Rate—The total rate of registration requests processed by the home agent, 
including only those registration requests that were authenticated by the 
AAA server.
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Registration Requests

The Registration Requests pane shows:

Standby Synchronization

The Standby Synchronization pane shows:

Field Description

Current Bindings • Count—The current number of entries in the home agent’s mobility binding 
list. The home agent updates this number in response to registration events 
from mobile nodes.

• Rate—The count can increment or decrease, resulting in a positive or 
negative rate.

Initial Received • Count—Total number of initial registration requests received by the HA.

• Rate—Rate at which initial registration requests are received by the HA.

Initial Denied • Count—Total number of initial registration requests denied by the HA.

• Rate—Rate at which initial registration requests are denied by the HA.

All Received • Count—Total number of all registration requests received by the HA.

• Rate—Rate at which all registration requests are received by the HA.

All Denied • Count—Total number of all registration requests denied by the HA.

• Rate—Rate at which all registration requests are denied by the HA.

Field Description

Binding Updates 
Sent

• Count—Total number of binding updates sent by the home agent to a standby 
home agent.

• Rate—Total rate of binding updates sent by the home agent to a standby 
home agent.

Binding Updates 
Unacknowledged

• Count—Total number of binding updates sent by the home agent for which 
no acknowledgement is received from the standby home agent.

• Rate—Total rate of binding updates sent by the home agent for which no 
acknowledgement is received from the standby home agent.
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IP Local Pool Config

Note For toolbar details, see Using the Toolbar, page 11-6.

The IP Local Pool Config subtab shows IP addresses for HA nodes and contains:

IP Local Pool Stats

Note For toolbar details, see Using the Toolbar, page 11-6.

The IP Local Pool Stats subtab shows IP addresses and IP addresses in use for HA nodes and contains:

Column Description

Name Name that uniquely identifies an IP local pool. This name must be unique among 
all the local IP pools even when they belong to different pool groups.

Addresses: Low This object specifies the first IP address of the range of IP addresses contained 
by this pool entry. This address must be less than or equal to the High address.

Addresses: High This object specifies the last IP address of the range of IP addresses mapped by 
this pool entry. If only a single address is being mapped, the value of this object 
is equal to the Low value.

Addresses: Free Number of IP addresses available for use in the range of IP addresses.

Addresses: In Use Number of IP addresses being used in the range of IP addresses.

Priority This object specifies the priority of the IP local pool. IP local pools will be used 
in assigning IP addresses in the order of priority.

Column Description

Name Name that uniquely identifies an IP local pool. This name must be unique among 
all the local IP pools even when they belong to different pool groups.

Addresses: Free Number of IP addresses available for use in this IP local pool.

Addresses: In Use Number of IP addresses being used in this IP local pool.

Addresses: 
Maximum In Use

Contains the high water mark of used addresses in an IP local pool since pool 
creation, since the system was restarted, or since this object was reset, whichever 
occurred last.

Addresses In Use: 
Low Threshold

When the number of used addresses in an IP local pool falls below this threshold 
value, a notification is generated.

Addresses In Use: 
High Threshold

When the number of used addresses in an IP local pool is equal or exceeds this 
threshold value, a notification is generated.
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Displaying GGSN Real-Time Statistics
The MWTM enables you to display real-time statistics only in the MWTM web interface for Gateway 
GPRS Support Nodes (GGSNs) that reside on the Service and Application Module for IP (SAMI). To 
display GGSN real-time statistics, select a SAMI-based GGSN node in the navigation tree and click the 
Statistics tab. These subtabs appear:

• Global, page 11-62

• SGSN Throughput, page 11-67

• APN, page 11-68

• IP Local Pool Config, page 11-72

• IP Local Pool Stats, page 11-73

Global

Note For toolbar details, see Using the Toolbar, page 11-6.

The Global subtab shows global statistics for GGSN nodes and contains:

• GTP Statistics, page 11-63

• Charging Statistics, page 11-63

• GTP Throughput Statistics Ext, page 11-63

• PDP Context Statistics, page 11-64

• AAA Authentication Statistics, page 11-66

• AAA Accounting Statistics, page 11-66

• IP and UDP Statistics, page 11-67

Addresses In Use: 
Low Threshold 
Percentage

When the percentage of used addresses in an IP local pool falls below this 
threshold value, a notification is generated. 

Addresses In Use: 
High Threshold 
Percentage

When the percentage of used addresses in an IP local pool is equal or exceeds 
this threshold value, a notification is generated. 

Column Description
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GTP Statistics

The GTP Statistics pane displays statistics about the GPRS Tunneling Protocol (GTP) and contains:

Charging Statistics

The Charging Statistics pane displays count and rate statistics for GGSN charging messages and 
contains:

GTP Throughput Statistics Ext

The GTP Throughput Statistics Ext pane displays count and rate statistics about GTP throughput and 
contains:

Field Description

GTP Signaling 
Messages

GTP signaling messages sent between the Serving GPRS Support Node (SGSN) 
and GGSN.

G-PDU Messages GTP Packet Data Unit (G-PDU) messages sent or received on an SGSN path.

G-PDU Octets G-PDU bits sent or received in a GTP PDU message on an SGSN path. 

Unexpected GTP 
Signaling Messages 

Number of unexpected GTP signaling messages sent or received.

GTP Messages with 
Parser Errors 

Number of GTP messages received with wrong value.

Sent • Count—Number of messages or bits in the transmit direction. 

• Rate—The transmit rate of the messages or bits.

Received • Count—Number of messages or bits in the receive direction.

• Rate—The receive rate of the messages or bits.

Field Description

G-CDR Messages 
Pending

• Count—GGSN Call Detail Records (CDRs) that are pending.

• Rate—Rate (per second) of pending G-CDR messages.

G-CDR Messages 
Sent

• Count—Total number of G-CDRs sent.

• Rate—Rate (per second) of sent G-CDR messages.

Field Description

GTP Packets GTP packets between the GGSN and SGSN.

GTP Bytes GTP bytes between the GGSN and SGSN.

Sampling Interval 
in Minutes: 3

Global GTP throughput statistics on the GGSN for a duration of 3 minutes.

Sampling Interval 
in Minutes: 5

Global GTP throughput statistics on the GGSN for a duration of 5 minutes. 
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PDP Context Statistics

The PDP Context Statistics pane shows count and rate values for these statistics:

Data age (minutes) The difference in minutes between the time when the data was collected and 
retrieved. This is the time that has elapsed after the previous collection or update 
of the data.

Upstream Rate (per second) of upstream GTP traffic during the last sampling period.

Downstream Rate (per second) of downstream GTP traffic during the last sampling period.

Field Description

Field Description

Active GTP v0 PDP Contexts • Count—PDP contexts (GTP version 0) that are active.

• Rate—The rate of active PDP contexts (GTP version 0).

Active GTP v1 PDP Contexts • Count—PDP contexts (GTP version 1) that are active.

• Rate—The rate of active PDP contexts (GTP version 1).

PDP Contexts Created • Count—PDP contexts that were created.

• Rate—Rate of PDP contexts that were created.

PDP Contexts Deleted • Count—PDP contexts that were deleted.

• Rate—Rate of PDP contexts that were deleted.

PDP Context Activations 
Rejected

• Count—PDP contexts for which the activation request was rejected.

• Rate—Rate of PDP contexts for which the activation request was rejected.

PDP PPP-Regen Interfaces 
Created 

• Count—Device-specific interfaces created for association with PDP contexts 
regenerated to a PPP session.

• Rate—Rate of device-specific interfaces created for association with PDP contexts 
regenerated to a PPP session.

Active PDP Contexts with 
Direct Tunnel 

• Count—Active PDP contexts with direct tunnel enabled.

• Rate—Rate of active PDP contexts with direct tunnel enabled.

PDP Contexts Deleted Without 
Waiting for the SGSN

• Count—PDPs deleted in the GGSN without waiting for a delete context response from 
the SGSN.

• Rate—Rate of PDPs deleted in the GGSN without waiting for a delete context response 
from the SGSN.

PDP Contexts Deleted Without 
Sending to the SGSN

• Count—PDPs deleted in the GGSN without sending a delete request to the SGSN.

• Rate—Rate of PDPs deleted in the GGSN without sending a delete request to the SGSN.

Update PDP Context Requests 
Sent 

• Count—Update PDP context requests that the GGSN initiated and that were sent to the 
SGSN.

• Rate—Rate of update PDP context requests that the GGSN initiated and that were sent 
to the SGSN.
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Update PDP Context 
Responses Received 

• Count—Update PDP context responses received from the SGSN for the GGSN-initiated 
update requests.

• Rate—Rate of update PDP context responses received from the SGSN for the 
GGSN-initiated update requests.

COA Messages Received • Count—Change of Authorization (COA) messages received at the GGSN.

• Rate—Rate of COA messages received at the GGSN.

COA Messages Dropped • Count—COA messages dropped at the GGSN.

• Rate—Rate of COA messages dropped at the GGSN.

COA QOS Updates Sent • Count—Update PDP requests for QOS changes that COA initiated and that are sent 
from the GGSN.

• Rate—Rate of update PDP requests for QOS changes that COA initiated and that are 
sent from the GGSN.

Error Indication Messages 
Received 

• Count—Number of error indication messages received on the GGSN.

• Rate—Rate of error indication messages received on the GGSN.

Direct Tunnels Enabled • Count—Direct tunnels enabled for the PDP contexts in the GGSN.

• Rate—Rate of direct tunnels enabled for the PDP contexts in the GGSN.

Error Indications for DT PDP 
Contexts 

• Count—Error indications received for Direct Tunnel (DT) PDP contexts from the Radio 
Network Controller (RNC).

• Rate—Rate of error indications received for Direct Tunnel (DT) PDP contexts from the 
Radio Network Controller (RNC).

DT PDP Contexts Deleted Due 
to Update Response 

• Count—Direct tunnel PDP contexts deleted because of update response failure.

• Rate—Rate of direct tunnel PDP contexts deleted because of update response failure.

PDP Context Activations 
Failure Ratio

• Count—Number of PDP context activation failures.

• Rate—Rate of PDP context activation failures.

PDP Context Requests 
Rejected due to Insufficient 
Resources

• Count—Number of PDP context requests rejected due to insufficient resources.

• Rate—Rate of PDP context requests rejected due to insufficient resources.

PDP Context Requests 
Rejected due to Insufficient 
Resources for PPP 
Regeneration

• Count—Number of PDP context Requests rejected due to insufficient resources for PPP 
regeneration.

• Rate—Rate of PDP context requests rejected due to insufficient resources for PPP 
regeneration.

PDP Context Requests 
Dropped due to the PPP 
Regeneration Threshold Limit

• Count—Number of PDP context requests dropped due to the PPP regeneration 
threshold limit.

• Rate—Rate of PDP context requests dropped due to the PPP regeneration threshold 
limit.

PDP Context Messages with 
TFT Semantic Errors

• Count—Number of PDP context messages with TFT semantic errors.

• Rate—Rate of PDP context messages with TFT semantic errors.

PDP Context Messages with 
TFT Syntax Errors

• Count—Number of PDP context messages with TFT syntax errors.

• Rate—Rate of PDP context messages with TFT syntax errors.

Field Description
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AAA Authentication Statistics

AAA Authentication Statistics pane shows:

AAA Accounting Statistics

AAA Accounting Statistics pane shows:

PDP Context Messages with 
Packet Filter Syntax Errors

• Count—Number of PDP context messages with packet filter syntax errors.

• Rate—Rate of PDP context messages with packet filter syntax errors.

PDP Context Messages with 
Packet Filter Semantic Errors

• Count—Number of PDP context messages with packet filter semantic errors.

• Rate—Rate of PDP context messages with packet filter semantic errors.

Error indication Messages Sent • Count—Number of error indication messages sent.

• Rate—Rate at which the error indication messages are sent.

Field Description

Field Description

Server Name Name of the server.

Server State Whether the server is up (operational) or down (not operational).

Transactions 
Completed

• Count—Number of authentication transactions with the server which succeeded since it is made active.

• Rate—Rate at which the authentication transactions with the server are succeeded since it is made 
active.

Transaction 
Failures

• Count—Number of authentication transactions with this server which failed since it is made active. 

• Rate—Rate at which the authentication transactions with the server are failed since it is made 
active.

Requests • Count—Number of authentication requests sent to this server since it is made active. 

• Rate—Rate at which the authentication requests are sent to the server since it is made active.

Request Timeouts • Count—Number of authentication requests which are timed out since it is made active. 

• Rate—Rate at which the authentication requests are timed out since it is made active.

Error Responses • Count—Number of server ERROR authentication responses received from this server since it is made 
active.

• Rate—Rate at which the server ERROR authentication responses are received from the server since it 
is made active.

Incorrect 
Responses

• Count—Number of authentication responses which could not be processed since it is made active. 

• Rate—Rate (per second) of authentication responses which could not be processed since it is made 
active.

Field Description

Server Name Name of the server.

Server State Whether the server is up (operational) or down (not operational).
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IP and UDP Statistics

The IP and UDP Statistics pane shows:

SGSN Throughput

Note For toolbar details, see Using the Toolbar, page 11-6.

Transactions 
Completed

• Count—Number of accounting transactions with the server which succeeded since system 
reinitialization.

• Rate—Rate at which the accounting transactions with the server are succeeded since it is made 
active.

Transaction 
Failures

• Count—Number of accounting transactions with this server which failed since system reinitialization. 

• Rate—Rate at which the accounting transactions with the server are failed since it is made active.

Requests • Count—Number of accounting requests sent to this server since system reinitialization. 

• Rate—Rate at which the accounting requests are sent to the server since it is made active.

Request Timeouts • Count—Number of accounting requests which have timed out since system reinitialization.

• Rate—Rate at which the accounting requests are timed out since it is made active.

Error Responses • Count—Number of server ERROR accounting responses received from this server since system 
reinitialization.

• Rate—Rate at which the server ERROR accounting responses are received from the server since it is 
made active.

Incorrect 
Responses

• Count—Number of accounting responses which could not be processed since system reinitialization. 

• Rate—Rate of accounting responses which could not be processed since system reinitialization.

Field Description

Field Description

IP In Header Errors Input datagrams discarded because of errors in their IP headers, including bad 
checksums, version number mismatches, other format errors, time-to-live 
exceeded, and errors discovered in processing their IP options.

IP Out Discards Outbound packets that were discarded although no errors were detected. One 
reason for discarding a packet would be to free buffer space.

IP Out No Routes IP datagrams discarded because no route could be found to transmit them. This 
statistic includes any datagrams that a host cannot route because all its default 
gateways are down.

IP Reassembly 
Fails 

Failures detected by the IP reassembly algorithm.

IP Routing 
Discards 

Routing entries that were discarded even though they are valid. One reason for 
discarding a routing entry would be to free buffer space for other routing entries.

UDP In Datagrams UDP datagrams delivered to UDP users.
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The SGSN Throughput subtab shows:

APN

Note For toolbar details, see Using the Toolbar, page 11-6.

The APN subtab contains:

• APN Instance Throughput, page 11-68

• APN Instance Throughput Ext, page 11-69

• APN Instance PDP, page 11-69

• APN Instance PDP Ext, page 11-70

• APN Instance Miscellaneous, page 11-71

APN Instance Throughput

To view the APN Instance Throughput Statistics table, choose this option from the Type drop-down 
menu. The GUI displays the count and rate values for these statistics:

Field Description

SGSN Name Name of the SGSN.

Sampling Interval 
in Minutes: 3

Throughput statistics on the SGSN for a duration of 3 minutes. 

Sampling Interval 
in Minutes: 5

Throughput statistics on the SGSN for a duration of 5 minutes. 

Upstream Packets Rate (per second) of upstream packets sent on this SGSN during the last sampling 
period.

Upstream Bytes Rate (per second) of upstream bytes sent on this SGSN during the last sampling 
period.

Downstream 
Packets

Rate (per second) of downstream packets sent on this SGSN during the last 
sampling period.

Downstream Bytes Rate (per second) of downstream bytes sent on this SGSN during the last 
sampling period.

Data age (minutes) The difference in minutes between the time when the data was collected and 
retrieved. This is the time that has elapsed after the previous collection or update 
of the data.

Field Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Upstream Bits • Count—Number of upstream bits sent on this APN during the last sampling period.

• Rate—Rate (per second) of upstream bits sent on this APN during the last sampling period.
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APN Instance Throughput Ext

To view the APN Instance Throughput Ext Statistics table, choose this option from the Type drop-down 
menu. The GUI displays the count and rate values for these statistics:

APN Instance PDP

To view the APN Instance PDP Statistics table, choose this option from the Type drop-down menu. The 
GUI displays the count and rate values for these statistics:

Downstream Bits • Count—Number of downstream bits sent on this APN during the last sampling period.

• Rate—Rate (per second) of downstream bits sent on this APN during the last sampling period.

Upstream Packets • Count—Number of upstream packets sent on this APN during the last sampling period.

• Rate—Rate (per second) of upstream packets sent on this APN during the last sampling period.

Downstream Packets • Count—Number of downstream packets sent on this APN during the last sampling period.

• Rate—Rate (per second) of downstream packets sent on this APN during the last sampling 
period.

Field Description

Field Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Sampling Interval in 
Minutes: 3

Throughput statistics on the APN for a duration of 3 minutes. 

Sampling Interval in 
Minutes: 5

Throughput statistics on the APN for a duration of 5minutes. 

Upstream Packets Rate (per second) of upstream packets sent on this APN during the last sampling period.

Upstream Bits Rate (per second) of upstream bytes sent on this APN during the last sampling period.

Downstream Packets Rate (per second) of downstream packets sent on this APN during the last sampling period.

Downstream Bytes Rate (per second) of downstream bytes sent on this APN during the last sampling period.

Data Age (minutes) The difference in minutes between the time when the data was collected and retrieved. This is the 
time that has elapsed after the previous collection or update of the data. 

Field Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Active PDP/Bearers • Count—Current number of active PDP/Bearer contexts on this APN.
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APN Instance PDP Ext

To view the APN Instance PDP Statistics table, choose this option from the Type drop-down menu. The 
GUI displays the count and rate values for these statistics:

PDP/Bearer Activations by MS Success • Count—Total number of successfully completed PDP/Bearer context activation 
procedures by the MS on this APN.

• Rate—Rate (per second) of successfully completed PDP/Bearer context 
activation procedures by the MS on this APN.

• Ratio—Number of successful activations for every 100 activation attempts.

PDP/Bearer Activations by MS Failure • Count—Total number of failed PDP/Bearer context activation procedures by the 
MS on this APN.

• Rate—Rate (per second) of failed PDP/Bearer context activation procedures by 
the MS on this APN.

PDP/Bearer Deactivations by Network 
Success

• Count—Total number of successfully completed PDP/Bearer context 
deactivation procedures by the GGSN on this APN.

• Rate—Rate (per second) of successfully completed PDP/Bearer context 
deactivation procedures by the GGSN on this APN.

PDP/Bearer Deactivations by Network 
Failure

• Count—Total number of failed PDP/Bearer context deactivation procedures by 
the GGSN on this APN.

• Rate—Rate (per second) of failed PDP/Bearer context deactivation procedures 
by the GGSN on this APN.

PDP/Bearer Deactivations by Network 
PDP/Bearer Retainability

• Ratio—For every 100 PDP/Bearer contexts, the number of activations whose 
deactivation was not completed by the GGSN. 

PDP/Bearer Deactivations By MS 
Success

• Count—Total number of successfully completed PDP/Bearer context 
deactivation procedures by the MS on this APN.

• Rate—Rate (per second) of successfully completed PDP/Bearer context 
deactivation procedures by the MS on this APN.

• Ratio—Number of successful deactivations for every 100 deactivation attempts.

PDP/Bearer Deactivations By MS 
Failure

• Count—Total number of failed PDP/Bearer context deactivation procedures by 
the MS on this APN.

• Rate—Rate (per second) of failed PDP/Bearer context deactivation procedures by 
the MS on this APN.

Field Description

Field Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.
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APN Instance Miscellaneous

To view the APN Miscellaneous Statistics table, choose this option from the Type drop-down menu. The 
GUI displays count and rate values for these statistics:

Dynamic PDP/Bearer Activations By 
MS Success

• Count—Total number of successfully completed dynamic PDP/Bearer context 
activation procedures initiated by MS on this APN.

• Rate—Rate (per second) of successfully completed dynamic PDP/Bearer 
context activation procedures initiated by MS on this APN.

• Ratio—Number of successful dynamic activations for every 100 dynamic 
activation attempts.

Dynamic PDP/Bearer Activations By 
MS Failure

• Count—Total number of failed dynamic PDP/Bearer context activation 
procedures initiated by MS on this APN.

• Rate—Rate (per second) of failed dynamic PDP/Bearer context activation 
procedures initiated by MS on this APN.

Dynamic PDP/Bearer Activations By 
Network Success

• Count—Total number of successfully completed network initiated PDP/Bearer 
context activation procedures.

• Rate—Rate (per second) of successfully completed network initiated 
PDP/Bearer context activation procedures.

• Ratio—Number of successful network initiated activations for every 100 
activation attempts.

Dynamic PDP/Bearer Activations By 
Network Failure

• Count—Total number of failed network initiated PDP/Bearer context activation 
procedures.

• Rate—Rate (per second) of failed network initiated PDP/Bearer context 
activation procedures.

PDP/Bearer Updates By Network 
Success

• Count—Total number of successful update responses received from the SGSN for 
GGSN initiated update requests on this APN.

• Rate—Rate (per second) of successful update responses received from the SGSN 
for GGSN initiated update requests on this APN.

• Ratio—Number of successful update responses received for every 100 update 
attempts.

PDP/Bearer Updates By Network Failure • Count—Total number of failed update responses received from the SGSN for 
GGSN initiated update requests on this APN.

• Rate—Rate (per second) of failed update responses received from the SGSN for 
GGSN initiated update requests on this APN.

Field Description

Field Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.
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IP Local Pool Config

Note For toolbar details, see Using the Toolbar, page 11-6.

DHCP Requests 
Success

• Count—Total number of successful DHCP address request sent by the GGSN 
or PDNGW on this APN.

• Rate—Rate at which the successful DHCP address requests are sent by the 
GGSN or PDNGW on this APN.

• Ratio—Number of successful DHCP requests for every 100 DHCP requests.

DHCP Requests 
Failure

• Count—Total number of unsuccessful DHCP address request sent by the GGSN 
or PDNGW on this APN.

• Rate—Rate at which the unsuccessful DHCP address requests are sent by the 
GGSN or PDNGW on this APN.

DHCP Releases • Count—Total number of DHCP address release request sent by the GGSN or 
PDNGW on this APN.

• Rate—Rate at which the DHCP address release request is sent by the GGSN 
or PDNGW on this APN.

COA Message 
Success

• Count—Number of successfully acknowledged COA messages by the GGSN or 
PDNGW with a COA ACK.

• Rate—Rate of successfully acknowledged COA messages by the GGSN or 
PDNGW with a COA ACK.

• Ratio—Number of successfully acknowledged COA messages for every 100 
COA messages received on this APN.

COA Message 
Failure

• Count—Number of unsuccessfully acknowledged COA messages by the GGSN 
or PDNGW with a COA ACK.

• Rate—Rate of unsuccessfully acknowledged COA messages by the GGSN or 
PDNGW with a COA ACK.

Direct Tunnels 
Enabled

• Count—Direct tunnels enabled for the PDP contexts on this APN.

• Rate—Rate at which the direct tunnels are enabled for the PDP contexts on 
this APN.

Field Description
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The IP Local Pool Config subtab shows IP addresses for GGSN, PDNGW, or SGW nodes and contains:

IP Local Pool Stats

Note For toolbar details, see Using the Toolbar, page 11-6.

The IP Local Pool Stats subtab shows IP addresses and IP addresses in use for GGSN, PDNGW, or SGW 
nodes and contains:

Displaying PDSN Real-Time Statistics
The MWTM enables you to display real-time statistics for Packet Data Serving Node (PDSN) nodes in 
the MWTM web interface. To display PDSN real-time statistics, select a PDSN node in the navigation 
tree and click the Statistics tab. The following option appears under Type drop-down menu:

• System Statistics, page 11-73

System Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

Field Description

Name Name of the IP local pool.

Addresses • Low—The first IP address of the range of IP addresses contained by this pool 
entry.

• High—The last IP address of the range of IP addresses mapped by this pool 
entry.

• Free—Number of IP addresses available for use within the range of IP 
addresses.

• In Use—Number of IP addresses being used within the range of IP 
addresses.

Field Description

Name Name of the IP local pool.

Addresses • Free—Number of IP addresses available for use in this IP local pool.

• In Use—Number of IP addresses being used in this IP local pool.

• Maximum in Use—The maximum number of used addresses in an IP local 
pool since pool creation, since the system was restarted, or since this object 
was reset, whichever occurred last.
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To view the System Statistics, choose this option from Type drop-down menu. The GUI displays the 
following categories:

• Session Statistics, page 11-74

• Flow Statistics, page 11-75

• Session Bandwidth Statistics, page 11-76

• PCF Statistics, page 11-76

• Traffic Statistics, page 11-77

Session Statistics

The Session Statistics pane contains:

Field Description

Maximum Allowed 
Sessions 

• Count—Maximum number of sessions allowed by the system.

Session Failure 
Ratio

• Count—Ratio of session failures.

Session Utilization • Count—Total session utilization.

Total Active 
Sessions 

• Count—Total number of sessions in active state.

Total Dormant 
Sessions 

• Count—Total number of sessions in dormant state.

Total HDLC over 
GRE Sessions 

• Count—Total number of HDLCoGRE sessions currently established with the 
system.

Total PPP over 
GRE Sessions 

• Count—Total number of PPPoGRE sessions currently established with the 
system.

Total Session 
Failures

• Count—Number of A10/A11 session failures occurring since PDSN agent 
restarted.

Total Sessions • Count—Total number of sessions currently established with the system.

Total Sessions 
Established 

• Count—Total number of sessions established since system was last restarted.

Total Sessions 
Established Rate 

• Count—Rate at which the sessions were established since system was last 
restarted.

Total Sessions 
Release

• Count—Total number of sessions released since system was last restarted.

Total Sessions 
Released Rate 

• Count—Rate at which the sessions were released since system was last 
restarted.
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Flow Statistics

The Flow Statistics pane contains:

Field Description

Flow Failure Ratio • Count—Ratio of flow failures.

Total Mobile IP 
Flow Failures

• Count—Total number of mobile IP flow setup request failed since system 
reboot.

• Rate—Rate of mobile IP flow setup request failed since system reboot.

Total Mobile IP 
Flows 

• Count—Total number of flows currently using MoIP services.

Total Mobile IP 
Flows Established 

• Count—Total number of mobile IP flow that has been established successfully 
since system reboot.

• Rate—Rate of mobile IP flow that has been established successfully since 
system reboot.

Total MSID Flows • Count—Total number of flows currently using MSID service.

Total Proxy Mobile 
IP Flow Failures 

• Count—Total number of proxy mobile IP flow setup request failed since system 
reboot.

• Rate—Rate of proxy mobile IP flow setup request failed since system reboot.

Total Proxy Mobile 
IP Flows 

• Count—Total number of flows currently using proxy MoIP service.

Total Proxy Mobile 
IP Flows 
Established 

• Count—Total number of proxy mobile IP flow that has been established 
successfully since system reboot.

• Rate—Rate of proxy mobile IP flow that has been established successfully 
since system reboot.

Total Simple IP 
Flow Failures 

• Count—Total number of simple IP flow setup request failed since last system 
reboot.

• Rate—Rate of simple IP flow setup request failed since last system reboot.

Total Simple IP 
Flows

• Count—Total number of flows currently using simple IP service.

Total Simple IP 
Flows Established 

• Count—Total number of Simple IP flow that has been established successfully 
since system reboot.

• Rate—Rate of Simple IP flow that has been established successfully since 
system reboot.

Total Unknown 
Type Flow Failures 

• Count—Total number of unknown type flow setup request failed since last 
system reboot.

• Rate—Rate of unknown type flow setup request failed since last system reboot.

Total VPDN Flow 
Failures 

• Count—Total number of VPDN flow setup request failed since last system 
reboot.

• Rate—Rate of VPDN flow setup request failed since last system reboot.
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Session Bandwidth Statistics

The Session Bandwidth Statistics pane contains:

PCF Statistics

The PCF Statistics pane contains:

Total VPDN Flows • Count—The total number of flows currently using VPDN service.

Total VPDN Flows 
Established 

• Count—Total number of VPDN flow that has been established successfully 
since system reboot.

• Rate—Rate of VPDN flow that has been established successfully since system 
reboot.

Field Description

Field Description

Bandwidth 
Utilization

• Count—Total bandwidth that has been utilized.

Total Allocated 
Bandwidth

• Count—Total bandwidth allocated for sessions currently established on the 
PDSN.

Total Available 
Bandwidth

• Count—Bandwidth available on the PDSN system for creation of new sessions.

Total Configured 
Bandwidth

• Count—total bandwidth value configured via the CLI that would be supported 
by PDSN system.

Field Description

Maximum Allowed 
PCFs

• Count—Maximum number of PCF allowed by the system.

PCF Utilization • Count—Total PCF utilization.

Total PCFs • Count—Total number of PCF currently interacting with the system.
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Traffic Statistics

The Traffic Statistics pane contains:

Field Description

Proxy Mobile IP 
Packets Received 

• Count—Total number of proxy mobile IP data packets received from mobile 
stations by PDSN since system was last restarted.

• Rate—Rate at which the proxy mobile IP data packets are received from mobile 
stations by PDSN since system was last restarted.

Short Data Burst 
Packets Sent

• Count—Total number of SDB marked data packets sent to PCF from PDSN 
since system was last restarted.

• Rate—Rate at which the SDB marked data packets are sent to PCF from PDSN 
since system was last restarted.

Simple IP Packets 
Sent

• Count—Total number of simple IP data packets sent to mobile stations since 
system was last restarted.

• Rate—Rate at which the simple IP data packets are sent to mobile stations since 
system was last restarted.

Mobile IP Packets 
Sent

• Count—Total number of mobile IP data packets sent to mobile stations from 
PDSN since system was last restarted.

• Rate—Rate at which the mobile IP data packets are sent to mobile stations from 
PDSN since system was last restarted.

No Session Packet 
Discards

• Count—Total number of packets discarded from PCF because of missing 
session since system was last restarted.

• Rate—Rate at which the packets are discarded from PCF because of missing 
session since system was last restarted.

Proxy Mobile IP 
Packets Sent

• Count—Total number of proxy mobile IP data packets sent to mobile stations 
from PDSN since system was last restarted.

• Rate—Rate at which the proxy mobile IP data packets are sent to mobile 
stations from PDSN since system was last restarted.

Invalid GRE 
Protocol Packet 
Discards

• Count—Total number of packets discarded from PCF because of invalid GRE 
protocol since system was last restarted.

• Rate—Rate at which the packets are discarded from PCF because of invalid 
GRE protocol since system was last restarted.

Mobile IP Packets 
Received

• Count—Total number of mobile IP data packets received from mobile stations 
since system was last restarted.

• Rate—Rate at which the mobile IP data packets are received from mobile 
stations since system was last restarted.

Simple IP Bits Sent • Count—Total number of simple IP data octets (in unit of 1024 octets) sent to 
mobile stations from PDSN since system was last restarted.

• Rate—Rate at which the simple IP data octets (in unit of 1024 octets) are sent 
to mobile stations from PDSN since system was last restarted.
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Mobile IP Bits 
Received

• Count—Total number of mobile IP data octets (in unit of 1024 octets) received 
from mobile stations by PDSN since system was last restarted.

• Rate—Rate at which the mobile IP data octets (in unit of 1024 octets) are 
received from mobile stations by PDSN since system was last restarted.

Short Data Burst 
Bits Sent

• Count—Total number of SDB marked data octets sent to PCF from PDSN since 
system was last restarted.

• Rate—Rate at which the SDB marked data octets are sent to PCF from PDSN 
since system was last restarted.

Proxy Mobile IP 
Bits Sent

• Count—Total number of proxy mobile IP data octets (in unit of 1024 octets) sent 
to mobile stations from PDSN since system was last restarted.

• Rate—Rate at which the proxy mobile IP data octets (in unit of 1024 octets) are 
sent to mobile stations from PDSN since system was last restarted.

Mobile IP Bits Sent • Count—Total number of mobile IP data octets (in unit of 1024 octets) sent to 
mobile stations from PDSN since system was last restarted.

• Rate—Rate at which the mobile IP data octets (in unit of 1024 octets) are sent 
to mobile stations from PDSN since system was last restarted.

Proxy Mobile IP 
Bits Received

• Count—Total number of proxy mobile IP data octets (in unit of 1024 octets) 
received from mobile stations since system was last restarted.

• Rate—Rate at which the proxy mobile IP data octets (in unit of 1024 octets) are 
received from mobile stations since system was last restarted.

Simple IP Bits 
Received

• Count—Total number of simple IP data octets (in unit of 1024 octets) received 
from mobile stations by PDSN since system was last restarted.

• Rate—Rate at which the simple IP data octets (in unit of 1024 octets) are 
received from mobile stations by PDSN since system was last restarted.

No GRE Key 
Packet Discards

• Count—Total number of packets discarded from PCF because of the missing 
GRE Keying since system was last restarted.

• Rate—Rate at which the packets are discarded from PCF because of the missing 
GRE Key since system was last restarted.

Invalid Checksum 
Packet Discards

• Count—Total number of packets discarded from PCF because of invalid 
checksum since system was last restarted.

• Rate—Rate at which the packets are discarded from PCF because of invalid 
checksum since system was last restarted.

Simple IP Packets 
Received

• Count—Total number of simple IP data packets received from mobile stations 
since system was last restarted.

• Rate—Rate at which the simple IP data packets are received from mobile 
stations since system was last restarted.

Field Description
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Displaying SGW Real-Time Statistics
The MWTM enables you to display real-time statistics for SGW nodes in the MWTM web interface. To 
display real-time statistics, select the node in the navigation tree and click the Statistics tab. These 
options appear under the Type drop down list:

• AAA, page 11-79

• APN Instance Throughput, page 11-81

• APN Instance Throughput Ext, page 11-81

• APN Instance Bearer, page 11-82

• EPC Buffering, page 11-83

• EPC Overload Protection, page 11-84

• GTP Statistics, page 11-86

• GTPv2 Statistics, page 11-88

• GTPv2 Path Bearer Statistics, page 11-89

• GTPv2 Path Session Statistics, page 11-90

• GTP Path Error Statistics, page 11-91

• IP Local Pool Configuration, page 11-92

• IP Local Pool Statistics, page 11-92

AAA

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the AAA statistics table, choose this option from the Type drop-down menu. The GUI displays 
the following categories:

• AAA Authentication Statistics, page 11-79

• AAA Accounting Statistics, page 11-80

AAA Authentication Statistics

AAA Authentication Statistics pane shows:

Column Description

Server Name Name of the server.

Server State Whether the server is up (operational) or down (not operational).

Transactions 
Completed

• Count—Number of authentication transactions with the server which succeeded since it is made active.

• Rate—Rate at which the authentication transactions with the server are succeeded since it is made 
active.
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AAA Accounting Statistics

AAA Accounting Statistics pane shows:

Transaction 
Failures

• Count—Number of authentication transactions with this server which failed since it is made active. 

• Rate—Rate at which the authentication transactions with the server are failed since it is made 
active.

Requests • Count—Number of authentication requests sent to this server since it is made active. 

• Rate—Rate at which the authentication requests are sent to the server since it is made active.

Request Timeouts • Count—Number of authentication requests which are timed out since it is made active. 

• Rate—Rate at which the authentication requests are timed out since it is made active.

Error Responses • Count—Number of server ERROR authentication responses received from this server since it is made 
active.

• Rate—Rate at which the server ERROR authentication responses are received from the server since it 
is made active.

Incorrect 
Responses

• Count—Number of authentication responses which could not be processed since it is made active. 

• Rate—Rate of authentication responses which could not be processed since it is made active.

Column Description

Column Description

Server Name Name of the server.

Server State Whether the server is up (operational) or down (not operational).

Transactions 
Completed

• Count—Number of accounting transactions with the server which succeeded since system 
reinitialization.

• Rate—Rate at which the accounting transactions with the server are succeeded since it is made 
active.

Transaction 
Failures

• Count—Number of accounting transactions with this server which failed since system reinitialization. 

• Rate—Rate at which the accounting transactions with the server are failed since it is made active.

Requests • Count—Number of accounting requests sent to this server since system reinitialization. 

• Rate—Rate at which the accounting requests are sent to the server since it is made active.

Request Timeouts • Count—Number of accounting requests which have timed out since system reinitialization.

• Rate—Rate at which the accounting requests are timed out since it is made active.

Error Responses • Count—Number of server ERROR accounting responses received from this server since system 
reinitialization.

• Rate—Rate at which the server ERROR accounting responses are received from the server since it is 
made active.

Incorrect 
Responses

• Count—Number of accounting responses which could not be processed since system reinitialization. 

• Rate—Rate of accounting responses which could not be processed since system reinitialization.
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APN Instance Throughput

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the APN Instance Throughput Statistics table, choose this option from the Type drop-down 
menu. The GUI displays the count and rate values for these statistics:

APN Instance Throughput Ext

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the APN Instance Throughput Ext Statistics table, choose this option from the Type drop-down 
menu. The GUI displays:

Column Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Upstream Bits • Count—Number of upstream bits sent on this APN during the last sampling period.

• Rate—Rate (per second) of upstream bits sent on this APN during the last sampling period.

Downstream Bits • Count—Number of downstream bits sent on this APN during the last sampling period.

• Rate—Rate (per second) of downstream bits sent on this APN during the last sampling period.

Upstream Packets • Count—Number of upstream packets sent on this APN during the last sampling period.

• Rate—Rate (per second) of upstream packets sent on this APN during the last sampling period.

Downstream Packets • Count—Number of downstream packets sent on this APN during the last sampling period.

• Rate—Rate (per second) of downstream packets sent on this APN during the last sampling 
period.

Field Description

APN Name The name of the Access Point Name (APN). 

APN Index A unique numerical identifier for the APN. 

Sampling Interval in 
Minutes: 3

Throughput statistics on the APN for a duration of 3 minutes.

Sampling Interval in 
Minutes: 5

Throughput statistics on the APN for a duration of 5minutes.

Upstream Packets Rate (per second) of upstream packets sent on this APN during the last sampling period.

Upstream Bits Rate (per second) of upstream bits sent on this APN during the last sampling period.

Downstream Packets Rate (per second) of downstream packets sent on this APN during the last sampling period.
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APN Instance Bearer

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the APN Instance Bearer statistics table, choose this option from the Type drop-down menu. The 
GUI displays:

Downstream Bits Rate (per second) of downstream bits sent on this APN during the last sampling period.

Data Age (minutes) The difference in minutes between the time when the data was collected and retrieved. This is the 
time that has elapsed after the previous collection or update of the data.

Field Description

Field Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Active Bearers • Count—Total number of bearers on this APN.

Bearer Activations 
Success

• Count—Total number of successfully completed Bearer activation procedures by MS on this 
APN.

• Rate—Rate (per second) of successfully completed Bearer activation procedures by the MS 
on this APN.

• Ratio—Number of successful activations for every 100 activation attempts.

Bearer Activations 
Failure

• Count—Total number of failed Bearer activation procedures by the MS on this APN.

• Rate—Rate (per second) of failed Bearer activation procedures by the MS on this APN.

Bearer Deactivations 
Success

• Count—Total number of successfully completed Bearer deactivation procedures by the SGW 
on this APN.

• Rate—Rate (per second) of successfully completed Bearer deactivation procedures by the 
SGW on this APN.

Bearer Updates Success • Count—Total number of successful bearer update initiated by network.

• Rate—Rate (per second) of successful bearer update initiated by network.

• Ratio—Number of successful bearer update initiated by network for every 100 attempts.

Bearer Updates Failure • Count—Total number of unsuccessful bearer modify initiated by MME or SGSN.

• Rate—Rate at which the unsuccessful bearer modify initiated by MME or SGSN.

Bearer Modifications 
Success

• Count—Total number of successful bearer modify initiated by MME or SGSN.

• Rate—Rate (per second) of successful bearer modify initiated by MME or SGSN.

• Ratio—Number of successful bearer modify initiated by MME or SGSN for every 100 
initiation attempts.

Bearer Modifications 
Failure

• Count—Total number of unsuccessful bearer modify initiated by MME or SGSN.

• Rate—Rate at which the unsuccessful bearer modify initiated by MME or SGSN.
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EPC Buffering

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the EPC Buffering Statistics table, choose this option from the Type drop-down menu. The GUI 
displays the following categories:

• Buffering Configuration, page 11-83

• Buffering Status, page 11-83

• Buffering Statistics, page 11-84

Buffering Configuration

The Buffering Configuration pane shows:

Buffering Status

The Buffering Status pane shows:

Dedicated Bearer 
Activations Success

• Count—Total number of successful dedicated bearer creation initiated by network.

• Rate—Rate (per second) of successful dedicated bearer creation initiated by network.

• Ratio—Number of successful dedicated bearer creation for every 100 bearer creation 
attempts.

Dedicated Bearer 
Activations Failure

• Count—Total number of unsuccessful dedicated bearer activation procedures received on this 
APN.

• Rate—Rate (per second) of unsuccessful dedicated bearer activation procedures received on 
this APN.

Field Description

Field Description

Buffering Agent Status The state of buffering agent.

Maximum Buffer Size The maximum buffer size allocated for the buffering agent per bearer.

Buffer Duration The duration for which the buffering agent stores data before discarding it.

Maximum Packets Per 
Buffer

The maximum number of packets allowed per buffer.

Field Description

Total In Use Buffers • Count— Total number of buffers currently in use.

Total Buffered Packets • Count—Total number of packets buffered at present in the buffer.

Total Buffered Bits • Count—Total number of bits buffered at present in the buffer.

Total Buffers Available • Count—Current available buffer size.
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Buffering Statistics

The Buffering Statistics pane shows:

EPC Overload Protection

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the EPC Overload Protection Statistics table, choose this option from the Type drop-down menu. 
The GUI displays the following categories:

• Status Information, page 11-85

• Congestion Threshold Information, page 11-85

• Statistics Information, page 11-85

• Congestion Times, page 11-85

Field Description

Buffers Created • Count—Total number of buffers created.

• Rate—Rate at which the buffers are created.

Buffers Deleted • Count—Total number of buffers deleted.

• Rate—Rate at which the buffers are deleted.

Buffer Rejected Low 
Memory

• Count—Total number of times the buffer allocation is rejected due to low memory availability 
in the gateway.

• Rate—Rate at which the buffer allocation is rejected due to low memory availability in the 
gateway.

Buffers Timed Out • Count—Total number of buffers that got timed out.

• Rate—Rate at which the buffers got timed out.

Buffer Packets Enqueued • Count—Total number of packets enqueued to the buffering agent.

• Rate—Rate at which the packets are enqueued to the buffering agent.

Buffer Rejected Memory 
Unavailable

• Count—Total number of times the buffer allocation is rejected by gateway due to requested 
memory is greater than the total available buffers.

• Rate—Rate at which the buffer allocation is rejected by gateway due to requested memory is 
greater than the total available buffers.

Buffer Packets Dequeued • Count—Total number of packets dequeued from the buffering agent.

• Rate—Rate at which the packets are dequeued from the buffering agent.

Buffer Bits Enqueued • Count—Total bits of data enqueued to the buffering agent.

• Rate—Rate at which the bits of data are enqueued to the buffering agent.

Buffer Bits Dequeued • Count—Total bits of data dequeued from the buffering agent.

• Rate—Rate at which the bits of data are dequeued from the buffering agent.
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Status Information

The Status Information pane shows:

Congestion Threshold Information

The Congestion Threshold Information pane shows:

Statistics Information

The Statistics Information pane shows:

Congestion Times

The Congestion Times pane shows:

Field Description

Congestion Status The congestion gateway status.

Congestion DFP Weight The dfp value, which is used to measure the congestion level in the gateway. 

Field Description

Congestion Low 
Threshold %

The low threshold for congestion.

Congestion High 
Threshold %

The high threshold for congestion.

Field Description

Call Requests Dropped • Count—Total number of incoming calls dropped at the gateway.

• Rate—Rate at which the incoming calls are dropped at the gateway.

Times High Congestion 
Reached

• Count—The number of times high congestion occurred on the gateway.

• Rate—Rate at which the high congestion occurred on the gateway.

Times Low Congestion 
Reached

• Count—The number of times low congestion occurred on the gateway.

• Rate—Rate at which the low congestion are occurred on the gateway.

Field Description

Congestion Low • Last Occurrence—Timestamp at which the low congestion last occurred on the gateway.

• Last Duration—Duration of last low congestion.

Congestion High • Last Occurrence—Timestamp at which the high congestion last occurred on the gateway.

• Last Duration—Duration of last high congestion.
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GTP Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the GTP Statistics table, choose this option from the Type drop-down menu. The GUI displays 
the following categories:

• GTP Active Statistics, page 11-86

• Charging Statistics, page 11-86

• GTP Bearer Statistics, page 11-87

• GTP Throughput Statistics, page 11-87

• GTP Throughput Statistics Ext, page 11-88

• GTP Error Statistics, page 11-88

GTP Active Statistics

The GTP Statistics pane shows:

Charging Statistics

The Charging Statistics pane shows:

Column Description

Bearers • Count—Total number of bearers.

Users • Count—Total number of users.

Column Description

G-CDR Messages 
Pending

• Count—Number of G-CDRs pending.

• Rate—Rate (per second) of G-CDRs pending.

G-CDR Messages 
Sent

• Count—Number of G-CDRs sent.

• Rate—Rate at which the g-CDRs are sent.
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GTP Bearer Statistics

The GTP PDP/Bearer Statistics pane shows:

GTP Throughput Statistics

The GTP Throughput Statistics pane displays count and rate statistics about GTP throughput and shows:

Column Description

Bearer Activation 
Failure Ratio

• Count—Ratio of bearer activation request to bearer activation failures.

• Rate—Rate (per second) of ratio of bearer activation request to bearer 
activation failures.

Bearers Created • Count—Number of bearers created since the system is up.

• Rate—Rate at which the bearers are created since the system is up.

Bearers Rejected • Count—Number of bearers rejected since the system is up.

• Rate—Rate at which the bearers are rejected since the system is up.

Bearers Deleted • Count—Number of bearers deleted since the system is up

• Rate—Rate at which the bearers are deleted since the system is up.

Column Description

GTP signaling 
Messages Sent

• Count—Number of signalling messages sent on a SGSN path.

• Rate—Rate at which the signalling messages are sent on a SGSN path.

GTP Signalling 
Messages Received

• Count—Number of signalling messages received on a SGSN path.

• Rate—Rate at which the signalling messages are received on a SGSN path.

G-PDU Messages 
Sent

• Count—Number of PDU messages sent on a SGSN path.

• Rate—Rate at which the PDU messages are sent on a SGSN path.

G-PDU Messages 
Received

• Count—Number of PDU messages received on a SGSN path.

• Rate—Rate at which the PDU messages are received on a SGSN path.

G-PDU Bits Sent • Count—Number of PDU bits sent in PDU message on a SGSN path.

• Rate—Rate at which the PDU bits are sent in PDU message on a SGSN path.

G-PDU Bits 
Received

• Count—Number of PDU bits received in PDU message on a SGSN path.

• Rate—Rate at which the PDU bits are received in PDU message on a SGSN 
path.
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GTP Throughput Statistics Ext

The GTP Throughput Statistics Ext pane shows:

GTP Error Statistics

The GTP Error Statistics pane shows:

GTPv2 Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the GTPv2 Statistics table, choose this option from the Type drop-down menu. The GUI displays 
the following categories:

• GTPv2 Bearer Statistics, page 11-89

• GTPv2 Session Statistics, page 11-89

Field Description

GTP Packets GTP packets between the SGW and SGSN.

GTP Bytes GTP bytes between the SGW and SGSN.

Sampling Interval 
in Minutes: 3

Global GTP throughput statistics on the SGW for a duration of 3 minutes.

Sampling Interval 
in Minutes: 5

Global GTP throughput statistics on the SGW for a duration of 5 minutes. 

Upstream Rate (per second) of upstream GTP traffic during the last sampling period.

Downstream Rate (per second) of downstream GTP traffic during the last sampling period.

Data age (minutes) The difference in minutes between the time when the data was collected and 
retrieved. This is the time that has elapsed after the previous collection or update 
of the data.

Column Description

GTP Messages with 
Parser Errors

• Count—Number of GTP messages received with wrong value.

• Rate—Rate (per second) of GTP messages received with wrong value.

Dropped Signalling 
Messages

• Count—Number of signalling packets dropped by SGW.

• Rate—Rate at which the signalling packets are dropped by SGW.

Unexpected GTP 
Signalling 
Messages

• Count—Number of unexpected GTP signalling messages received.

• Rate—Rate at which the unexpected GTP signalling messages are received.
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GTPv2 Bearer Statistics

The GTPv2 Bearer Statistics pane shows:

GTPv2 Session Statistics

The GTPv2 Session Statistics pane shows:

GTPv2 Path Bearer Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

Field Description

Delete Bearer Responses Total number of delete bearer response messages.

Update Bearer Requests Total number of update bearer request messages.

Modify Bearer Requests Total number of modify bearer request messages.

Create Bearer Requests Total number of create bearer request messages.

Sent • Count—Total number of bearer response or bearer request messages sent.

• Rate—Rate at which the bearer response or bearer request messages are sent.

Received • Count—Total number of bearer response or bearer request messages received.

• Rate—Rate at which the bearer response or bearer request messages are received.

Rejected • Count—Total number of bearer response or bearer request messages rejected.

• Rate—Rate at which the bearer response or bearer request messages are rejected.

Field Description

Delete Session Responses Total number of delete session response messages.

Create Session Responses Total number of create session response messages.

Delete Session Requests Total number of delete session request messages.

Create Session Requests Total number of create session request messages.

Sent • Count—Total number of session response or session request messages sent.

• Rate—Rate at which the session response or session request messages are sent.

Received • Count—Total number of session response or session request messages received.

• Rate—Rate at which the session response or session request messages are received.

Rejected • Count—Total number of session response or session request messages rejected.

• Rate—Rate at which the session response or session request messages are rejected.
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To view the GTPv2 Path Bearer Statistics table, choose this option from the Type drop-down menu. The 
GUI displays:

GTPv2 Path Session Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

Field Description

GTP Path GTP path.

Create Requests Sent • Count—Total number of create bearer request messages sent.

• Rate—Rate at which the create bearer request messages are sent.

Create Requests Received • Count—Total number of create bearer request messages received.

• Rate—Rate at which the create bearer request messages are received.

Create Requests Rejected • Count—Total number of create bearer request messages rejected.

• Rate—Rate at which the create bearer request messages are rejected.

Modify Requests Sent • Count—Total number of modify bearer request messages sent.

• Rate—Rate at which the modify bearer request messages are sent.

Modify Requests 
Received

• Count—Total number of modifybearer request messages received.

• Rate—Rate at which the modify bearer request messages are received.

Modify Requests 
Rejected

• Count—Total number of modify bearer request messages rejected.

• Rate—Rate at which the modify bearer request messages are rejected.

Update Requests Sent • Count—Total number of update bearer request messages sent.

• Rate—Rate at which the update bearer request messages are sent.

Update Requests 
Received

• Count—Total number of update bearer request messages received.

• Rate—Rate at which the update bearer request messages are received.

Update Requests 
Rejected

• Count—Total number of update bearer request messages rejected

• Rate—Rate at which the update bearer request messages are rejected.

Delete Responses Sent • Count—Total number of delete bearer response messages sent.

• Rate—Rate at which the delete bearer response messages are sent.

Delete Responses 
Received

• Count—Total number of delete bearer response messages received

• Rate—Rate at which the delete bearer response messages are received.

Delete Responses 
Rejected

• Count—Total number of delete bearer response messages rejected.

• Rate—Rate at which the delete bearer response messages are rejected.
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To view the GTPv2 Path Session Statistics table, choose this option from the Type drop-down menu. The 
GUI displays:

GTP Path Error Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

Field Description

GTP Path GTP path.

Create Requests Sent • Count—Total number of create session request messages sent.

• Rate—Rate at which the create session request messages are sent.

Create Requests Received • Count—Total number of create session request messages received.

• Rate—Rate at which the create session request messages are received.

Create Requests Rejected • Count—Total number of create session request messages rejected.

• Rate—Rate at which the create session request messages are rejected.

Delete Requests Sent • Count—Total number of delete session request messages sent.

• Rate—Rate at which the delete session request messages are sent.

Delete Requests Received • Count—Total number of delete session request messages received.

• Rate—Rate at which the delete session request messages are received.

Delete Requests Rejected • Count—Total number of delete session request messages rejected.

• Rate—Rate at which the delete session request messages are rejected.

Create Responses Sent • Count—Total number of create session response messages sent.

• Rate—Rate at which the create session response messages are sent.

Create Responses 
Received

• Count—Total number of update session response messages received.

• Rate—Rate at which the update session response messages are received.

Create Responses 
Rejected

• Count—Total number of update session response messages rejected

• Rate—Rate at which the update session response messages are rejected.

Delete Responses Sent • Count—Total number of delete session response messages sent.

• Rate—Rate at which the delete session response messages are sent.

Delete Responses 
Received

• Count—Total number of delete session response messages received

• Rate—Rate at which the delete session response messages are received.

Delete Responses 
Rejected

• Count—Total number of delete session response messages rejected.

• Rate—Rate at which the delete session response messages are rejected.
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To view the GTP Path Error Statistics table, choose this option from the Type drop-down menu. The GUI 
displays:

IP Local Pool Configuration
The GUI displays the same fields as that of IP Local Pool Configuration statistics for GGSN node. See 
IP Local Pool Config, page 11-72.

IP Local Pool Statistics
The GUI displays the same fields as that of IP Local Pool statistics for GGSN node. See IP Local Pool 
Stats, page 11-73.

Displaying PDNGW Real time statistics
The MWTM enables you to display real-time statistics for PDNGW nodes in the MWTM web interface. 
To display real-time statistics, select the node in the navigation tree and click the Statistics tab. These 
options appear under the Type drop down list:

• AAA, page 11-93

• APN Instance Throughput, page 11-93

• APN Instance Throughput Ext, page 11-93

• APN Instance PDP/Bearer, page 11-93

• APN Instance PDP/Bearer Ext, page 11-94

• APN Instance Miscellaneous, page 11-95

• EPC Buffering, page 11-95

• EPC Overload Protection, page 11-95

• GTP Statistics, page 11-95

• GTPv2 Statistics, page 11-99

• GTPv2 Path Bearer Statistics, page 11-99

• GTPv2 Path Session Statistics, page 11-100

• GTP Path Error Statistics, page 11-100

Field Description

GTP Path GTP path.

Signalling Messages 
Dropped

Unexpected

• Count—Number of unexpected GTP signaling messages sent or received.

• Rate—Rate at which the unexpected GTP signaling messages are sent or received.

Dropped

• Count—Number of signaling messages that are dropped.

• Rate—Rate at which the signaling messages are dropped.
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• IP Local Pool Configuration, page 11-100

• IP Local Pool Statistics, page 11-101

AAA
The GUI displays the same fields as that of AAA Statistics for SGW node. See AAA, page 11-79.

APN Instance Throughput
The GUI displays the same fields as that of APN Instance Throughput Statistics for SGW node. See APN 
Instance Throughput, page 11-81.

APN Instance Throughput Ext
The GUI displays the same fields as that of APN Instance Throughput Ext Statistics for SGW node. See 
APN Instance Throughput Ext, page 11-81.

APN Instance PDP/Bearer

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the APN Instance PDP/Bearer Statistics table, choose this option from the Type drop-down 
menu. The GUI displays:

Field Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Active PDP/Bearers • Count—Number of active PDP contexts or Bearers on this APN.

PDP/Bearer Activations 
by MS Success

• Count—Total number of successfully completed PDP context/Bearer activation procedures 
by the MS on this APN.

• Rate—Rate (per second) of successfully completed PDP context/Bearer activation 
procedures by the MS on this APN.

• Ratio—Number of successful activations for every 100 activation attempts.

PDP/Bearer Activations 
by MS Failure

• Count—Total number of failed PDP context/Bearer activation procedures by the MS on this 
APN.

• Rate—Rate (per second) of failed PDP context/Bearer activation procedures by the MS on 
this APN.

PDP/Bearer 
Deactivations by Network 
Success

• Count—Total number of successfully completed PDP context/Bearer deactivation procedures 
by the PDNGW on this APN.

• Rate—Rate (per second) of successfully completed PDP context/Bearer deactivation 
procedures by the PDNGW on this APN.
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APN Instance PDP/Bearer Ext

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the APN Instance PDP/Bearer Ext Statistics table, choose this option from the Type drop-down 
menu. The GUI displays:

PDP/Bearer 
Deactivations by Network 
Failure

• Count—Total number of failed PDP context/Bearer deactivation procedures by the PDNGW 
on this APN.

• Rate—Rate (per second) of failed PDP context/Bearer deactivation procedures by the 
PDNGW on this APN.

PDP/Bearer Retainability • Ratio—For every 100 PDP contexts/Bearers, the number of activations whose deactivation 
was not completed by the network.

PDP/Bearer 
Deactivations by MS 
Success

• Count—Total number of successfully completed PDP context/Bearer deactivation procedures 
by the MS on this APN.

• Rate—Rate (per second) of successfully completed PDP context/Bearer deactivation 
procedures by the MS on this APN.

• Ratio—Number of successful deactivations for every 100 deactivation attempts.

PDP/Bearer 
Deactivations by MS 
Failure

• Count—Total number of failed PDP context/Bearer deactivation procedures by the MS on this 
APN.

• Rate—Rate (per second) of failed PDP context/Bearer deactivation procedures by the MS on 
this APN.

Field Description

Field Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Dynamic PDP/Bearer 
Activations By MS 
Success

• Count—Total number of successfully completed dynamic PDP context/Bearer activation 
procedures by the MS on this APN.

• Rate—Rate (per second) of successfully completed dynamic PDP context/Bearer activation 
procedures by the MS on this APN.

• Ratio—Number of successful dynamic activations for every 100 dynamic activation attempts.

Dynamic PDP/Bearer 
Activations By MS 
Failure

• Count—Total number of failed dynamic PDP context/Bearer activation procedures by the MS on 
this APN.

• Rate—Rate (per second) of failed dynamic PDP context/Bearer activation procedures by the MS 
on this APN.

PDP/Bearer Activations 
By Network Success

• Count—Total number of successfully completed network initiated PDP context/Bearer 
activation procedures.

• Rate—Rate (per second) successfully completed network initiated PDP context/Bearer 
activation procedures.

• Ratio—number of successful network initiated activations for every 100 activation attempts.
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APN Instance Miscellaneous
The GUI displays the same fields as that of APN instance Miscellaneous Statistics for GGSN node. See 
APN Instance Miscellaneous, page 11-71.

EPC Buffering
The GUI displays the same fields as that of EPC Buffering Statistics for SGW node. See EPC Buffering, 
page 11-83.

EPC Overload Protection
The GUI displays the same fields as that of EPC Overload protection Statistics for SGW node. See EPC 
Overload Protection, page 11-84.

GTP Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the GTP Statistics table, choose this option from the Type drop-down menu. The GUI displays 
the following categories:

• GTP Active Statistics, page 11-96

PDP/Bearer Activations 
By Network Failure

• Count—Total number of failed network initiated PDP context/Bearer activation procedures.

• Rate—Rate (per second) failed network initiated PDP context/Bearer activation procedures.

PDP/Bearer Updates By 
Network Success

• Count—Total number of successful update responses received on this APN.

• Rate—Rate (per second) of successful update responses received on this APN.

• Ratio—Number of successful update responses received for every 100 activation attempts.

PDP/Bearer Updates By 
Network Failure

• Count—Total number of unsuccessful update responses received on this APN.

• Rate—Rate (per second) of unsuccessful update responses received on this APN.

Dedicated Bearer 
Activations Success

• Count—Total number of successful dedicated bearer activation procedures received on this 
APN.

• Rate—Rate (per second) of successful dedicated bearer activation procedures received on this 
APN.

• Ratio—Number of successful dedicated bearer activation procedures for every 100 activation 
attempts.

Dedicated Bearer 
Activations Failure

• Count—Total number of unsuccessful dedicated bearer activation procedures received on this 
APN.

• Rate—Rate (per second) of unsuccessful dedicated bearer activation procedures received on 
this APN.

Field Description
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• Charging Statistics, page 11-96

• GTP PDP/Bearer Statistics, page 11-96

• GTP Throughput Statistics, page 11-97

• GTP Throughput Statistics Ext, page 11-88

• GTP Error Statistics, page 11-98

GTP Active Statistics

The GTP Active Statistics pane shows:

Charging Statistics

The Charging Statistics pane shows:

GTP PDP/Bearer Statistics

The GTP Bearer Statistics pane shows:

Column Description

GTP v0 PDP 
Contexts

PDP contexts (GTP version 0) that are active.

GTP v1 PDP 
Contexts

PDP contexts (GTP version 1) that are active.

GTP v2 EPS 
Bearers

EPS bearers (GTP version 2) that are active.

PPP Regen PDPs Device-specific interfaces created for association with PDP contexts regenerated 
to a Point-to-Point (PPP) session.

PPP PDPs Total number of point to point PDP contexts.

PDP Contexts with 
Direct Tunnel

Direct tunnels enabled for the PDP contexts in the PDNGW.

Column Description

G-CDR Messages 
Pending

• Count—Number of Call Detail Records (CDRs) pending.

• Rate—Rate (per second) of CDRs pending.

G-CDR Messages 
Sent

• Count—Number of G-CDRs sent.

• Rate—Rate at which the G-CDRs are sent.
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GTP Throughput Statistics

The GTP Throughput Statistics pane displays count and rate statistics about GTP throughput and shows:

Column Description

PDP/Bearer 
Context Activation 
Failure Ratio

• Count—Ratio of PDP/bearer activation request to bearer activation failures.

• Rate—Rate (per second) of ratio of PDP/bearer activation request to bearer 
activation failures.

PDP/Bearer 
Contexts Created

• Count—Number of PDP/bearers created since the system is up.

• Rate—Rate at which the PDP/bearers are created since the system is up.

PDP/Bearer 
Context Activations 
Rejected

• Count—Number of PDP/bearer activation requests rejected since the system 
is up.

• Rate—Rate at which the PDP/bearer activation requests are rejected since 
the system is up.

PDP/Bearer 
Contexts Deleted

• Count—Number of PDP/bearers deleted since the system is up

• Rate—Rate at which the PDP/bearers are deleted since the system is up.

Column Description

GTP Signaling 
Messages Sent

• Count—Number of signalling messages sent on a SGSN path.

• Rate—Rate at which the signalling messages are sent on a SGSN path.

GTP Signalling 
Messages Received

• Count—Number of signalling messages received on a SGSN path.

• Rate—Rate at which the signalling messages are received on a SGSN path.

G-PDU Messages 
Sent

• Count—Number of PDU messages sent on a SGSN path.

• Rate—Rate at which the PDU messages are sent on a SGSN path.

G-PDU Messages 
Received

• Count—Number of PDU messages received on a SGSN path.

• Rate—Rate at which the PDU messages are received on a SGSN path.

G-PDU Bits Sent • Count—Number of PDU bits sent in PDU message on a SGSN path.

• Rate—Rate at which the PDU bits are sent in PDU message on a SGSN path.

G-PDU Bits 
Received

• Count—Number of PDU bits received in PDU message on a SGSN path.

• Rate—Rate at which the PDU bits are received in PDU message on a SGSN 
path.
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GTP Throughput Statistics Ext

The GTP Throughput Statistics Ext pane shows:

GTP Error Statistics

The GTP Error Statistics pane shows:

Field Description

GTP Packets GTP packets between the PDNGW and SGSN.

GTP Bytes GTP bytes between the PDNGW and SGSN.

Sampling Interval 
in Minutes: 3

Global GTP throughput statistics on the PDNGW for a duration of 3 minutes.

Sampling Interval 
in Minutes: 5

Global GTP throughput statistics on the PDNGW for a duration of 5 minutes. 

Upstream Rate (per second) of upstream GTP traffic during the last sampling period.

Downstream Rate (per second) of downstream GTP traffic during the last sampling period.

Data age (minutes) The difference in minutes between the time when the data was collected and 
retrieved. This is the time that has elapsed after the previous collection or update 
of the data.

Column Description

PDP Context 
Activations 
Rejected due to 
Insufficient 
Resources

• Count—Number of PDP context requests rejected due to insufficient resources.

• Rate—Rate at which the PDP context requests are rejected due to insufficient resources.

PDP Context 
Requests Rejected 
due to Insufficient 
Resources 
Rejection for PPP 
Regeneration

• Count—Number of PDP context requests rejected due to insufficient resources for PPP 
regeneration.

• Rate—Rate at which the PDP context requests are rejected due to insufficient resources for PPP 
regeneration.

PDP Context 
Requests Dropped 
due to the PPP 
Regeneration 
Threshold Limit

• Count—Number of PDP context requests dropped due to the PPP regeneration threshold limit.

• Rate—Rate at which the PDP context requests are dropped due to the PPP regeneration threshold 
limit.

PDP Context 
Messages with 
Packet Filter 
Semantic Errors

• Count—Total number of received PDP context messages that had packet filters with semantic errors. 

• Rate—Rate at which the PDP context messages that had packet filters with semantic errors are received. 

PDP Context 
Messages with 
Packet Filter 
Syntax Errors

• Count—Total number of received PDP context messages that had packet filters with syntax errors. 

• Rate—Rate at which the PDP context messages that had packet filters with syntax errors are received. 
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GTPv2 Statistics
The GUI displays the same fields as that of GTPv2 Statistics for SGW node. See GTPv2 Statistics, 
page 11-88.

GTPv2 Path Bearer Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the GTPv2 Path Bearer Statistics table, choose this option from the Type drop-down menu. The 
GUI displays:

PDP Context 
Messages with TFT 
Syntax Errors

• Count—Total number of received PDP context messages that had Traffic Flow Templates (TFT) with 
syntax errors. 

• Rate—Rate at which the PDP context messages that had Traffic Flow Templates (TFT) with syntax 
errors are received.

PDP Context 
Messages with TFT 
Semantic Errors

• Count—Total number of received PDP context messages that had Traffic Flow Templates (TFT) with 
semantic errors. 

• Rate—Rate at which the PDP context messages that had Traffic Flow Templates (TFT) with semantic 
errors are received.

Unexpected GTP 
Signaling Messages

• Count—Number of unexpected GTP signaling messages sent or received.

• Rate—Rate at which the unexpected GTP signaling messages are sent or received.

Dropped GTP 
Signaling Messages

• Count—Number of dropped GTP signaling messages.

• Rate—Rate at which the GTP signaling messages are dropped.

GTP Message 
Parsers Errors

• Count—Number of GTP messages received with wrong value.

• Rate—Rate at which the GTP messages with wrong value are received.

Column Description

Field Description

GTP Path GTP path.

Create Requests Received • Count—Total number of create bearer request messages received.

• Rate—Rate at which the create bearer request messages are received.

Create Requests Rejected • Count—Total number of create bearer request messages rejected.

• Rate—Rate at which the create bearer request messages are rejected.

Modify Requests 
Received

• Count—Total number of modify bearer request messages received.

• Rate—Rate at which the modify bearer request messages are received.

Modify Requests 
Rejected

• Count—Total number of modify bearer request messages rejected.

• Rate—Rate at which the modify bearer request messages are rejected.
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GTPv2 Path Session Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the GTPv2 Path Session Statistics table, choose this option from the Type drop-down menu. The 
GUI displays:

GTP Path Error Statistics
The GUI displays the same fields as that of GTP Path Error Statistics for SGW node. See GTP Path Error 
Statistics, page 11-91.

IP Local Pool Configuration
The GUI displays the same fields as that of IP Local Pool Configuration statistics for GGSN node. See 
IP Local Pool Config, page 11-72.

Update Requests 
Received

• Count—Total number of update bearer request messages received.

• Rate—Rate at which the update bearer request messages are received.

Update Requests 
Rejected

• Count—Total number of update bearer request messages rejected.

• Rate—Rate at which the update bearer request messages are rejected.

Delete Responses Sent • Count—Total number of delete bearer response messages sent.

• Rate—Rate at which the delete bearer response messages are sent.

Field Description

Field Description

GTP Path GTP path.

Create Requests Received • Count—Total number of create session request messages received.

• Rate—Rate at which the create session request messages are received.

Create Requests Rejected • Count—Total number of create session request messages rejected.

• Rate—Rate at which the create session request messages are rejected.

Delete Requests Received • Count—Total number of delete session request messages received.

• Rate—Rate at which the delete session request messages are received.

Delete Requests Rejected • Count—Total number of delete session request messages rejected.

• Rate—Rate at which the delete session request messages are rejected.

Create Responses Sent • Count—Total number of create session response messages sent.

• Rate—Rate at which the create session response messages are sent.

Delete Responses Sent • Count—Total number of delete session response messages sent.

• Rate—Rate at which the delete session response messages are sent.
11-99
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.3

OL-22496-01



 

Chapter 11      Accessing Data from the Web Interface
  Displaying QoS Statistics
IP Local Pool Statistics
The GUI displays the same fields as that of IP Local Pool statistics for GGSN node. See IP Local Pool 
Stats, page 11-73.

Displaying QoS Statistics
You can view QOS real-time statistics for IP-RAN aggregation and cell-site routers that have both 
pseudo wires and RAN Optimized backhauls. To view QOS real-time statistics for one of these nodes, 
select the node in the navigation tree, then click the QoS tab. 

The following options appear under View drop-down menu:

• Config, page 11-101

• Class Map, page 11-101

• Queuing, page 11-102

• Match Statement, page 11-102

• Packet Marking, page 11-103

• Traffic Shaping, page 11-104

• Policing, page 11-104

Config

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Config details, choose Config option from the View drop-down menu. The GUI displays a 
bullet list/tree of the QOS configuration.

Class Map

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Class Map Statistics table, choose Class Map option from the View drop-down menu. The 
GUI displays:

Column Description

Class Map User-defined traffic class that contains one or many match statements used to 
classify packets into different categories.

Service Policy 
Direction

The direction of traffic for which the service policy is applied.

Pre-Policy Packets The number of inbound packets prior to executing any QoS policies.
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Queuing

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Queuing Statistics table, choose Queuing option from the View drop-down menu. The GUI 
displays:

Match Statement

Note For toolbar details, see Using the Toolbar, page 11-6.

Pre-Policy Bits The number of inbound octets prior to executing any QoS policies.

Pre-Policy Bits 
Rate

The rate of the traffic prior to executing any QoS policies.

Post-Policy Bits The number of outbound octets after executing QoS policies.

Post-Policy Bits 
Rate

The rate of the traffic after executing QoS policies

Dropped Packets The number of dropped packets per class as the result of all features that can 
produce drops.

Dropped Bits The number of dropped bits per class as the result of all features that can produce 
drops.

Drop Bits Rate The rate of the drops per class as the result of all features that can produce drops.

SRAM Buffer 
Dropped Packets

The number of drop packet count which occurred due to a lack of SRAM buffers 
during output processing on an interface.

Column Description

Column Description

Class Map User-defined traffic class that contains one or many match statements used to 
classify packets into different categories.

Service Policy 
Direction

The direction of traffic for which the service policy is applied.

Queue Depth The current depth of the queue.

Max Queue Depth The maximum depth of the queue.

Queue Discarded 
Bits

The count of octets, associated with this class, that were dropped by queueing.

Queue Discarded 
Packets

The number of packets, associated with this class, that were dropped by 
queueing.
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To view the Match Statement Statistics table, choose Match Statement option from the View drop-down 
menu. The GUI displays:

Packet Marking

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Packet Marking Statistics table, choose Packet Marking option from the View drop-down 
menu. The GUI displays:

Column Description

Class Map User-defined traffic class that contains one or many match statements used to 
classify packets into different categories.

Service Policy 
Direction

The direction of traffic for which the service policy is applied.

Match Statement The specific match criteria to identify packets for classification purposes.

Pre-Policy Packets The number of inbound packets prior to executing any QoS policies.

Pre-Policy Bits The number of inbound octets prior to executing any QoS policies.

Pre-Policy Bits 
Rate

The rate of the traffic prior to executing any QoS policies.

Column Description

Class Map User-defined traffic class that contains one or many match statements used to 
classify packets into different categories.

Service Policy 
Direction

The direction of traffic for which the service policy is applied.

DSCP Packets The number of packets whose DSCP field is marked by Set feature.

Precedence Packets The number of packets whose Precedence field is marked by Set feature.

QOS Group Packets The number of packets whose Qos Group field is marked by Set feature.

Frame Relay DE 
Packets

The number of packets whose Frame Relay DE Bit is marked by Set feature.

ATM CLP Packets The number of packets whose ATM CLP Bit is marked by Set feature.

Layer 2 COS 
Packets

The number of packets whose Layer 2 Cos field is marked by Set feature.

MPLS 
Experimental 
Imposition Packets

The number of packets whose MPLS Experimental Imposition field is marked by 
Set feature.

Discard Class 
Packets

The number of packets whose Discard Class field is marked by Set feature.

MPLS 
Experimental Top 
Most Packets

The number of packets whose MPLS Experimental Top Most field is marked by 
Set feature.
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Traffic Shaping

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Traffic Shaping Statistics table, choose this option from the View drop-down menu. The GUI 
displays:

Policing

Note For toolbar details, see Using the Toolbar, page 11-6.

SRP Priority 
Packets

The number of packets whose SRP Priority field is marked by Set feature.

DSCP Tunnel 
Packets

The number of packets whose DSCP Tunnel field is marked by Set feature.

Precedence Tunnel 
Packets

The number of packets whose Precedence Tunnel field is marked by Set feature.

Frame Relay FECN The number of packets whose Frame Relay FECN BECN field is marked by Set 
feature.

Column Description

Column Description

Class Map User-defined traffic class that contains one or many match statements used to 
classify packets into different categories.

Service Policy 
Direction

The direction of traffic for which the service policy is applied.

Active The current traffic-shaping state. When traffic-shaping is enabled and the traffic 
rate exceeds the shape rate, traffic-shaping is considered to be active. Otherwise, 
it is considered inactive.

Queue Size The current traffic-shaping queue depth in packets.

Delayed Bits The number of octets that have been delayed.

Delayed Packets The number of packets that have been delayed.

Dropped Bits The number of octets that have been dropped during shaping.

Dropped Packets The number of packets that have been dropped during shaping.
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To view the Policing Statistics table, choose Policing option from the View drop-down menu. The GUI 
displays:

Displaying PWE3 Real-Time Statistics
The MWTM enables you to display PWE3 real-time statistics in the MWTM web interface. Because the 
MWTM client also displays these statistics and the GUIs for the web and client interfaces are so similar, 
the PWE3 real-time statistics are described in Viewing PWE3 Statistics, page 8-115.

Displaying TDM Real-Time Statistics
The MWTM enables you to display TDM real-time statistics in the MWTM web interface. Because the 
MWTM client also displays these statistics and the GUIs for the web and client interfaces are so similar, 
the TDM real-time statistics are described in Viewing TDM Statistics, page 8-101.

Displaying SLB Real time statistics
The MWTM enables you to display SLB real-time statistics in the MWTM web interface, for the mSEF 
devices that support 7600 supervisor card. To display SLB real-time statistics, select the mSEF node that 
supports 7600 supervisor card in the navigation tree and click the Statistics tab. These options appear 
under the Type drop-down menu:

• Virtual Server, page 11-106

• Real Server, page 11-106

• Server Farms, page 11-107

• Global Statistics, page 11-108

Column Description

Class Map User-defined traffic class that contains one or many match statements used to 
classify packets into different categories.

Service Policy 
Direction

The direction of traffic for which the service policy is applied.

Conformed Packets The number of packets treated as conforming by the policing feature

Conformed Bits The number of octets treated as conforming by the policing feature

Conformed Bits 
Rate

The rate of conforming traffic.

Exceeded Packets The number of packets treated as non-conforming by the policing feature.

Exceeded Bits The number of octets treated as non-conforming by the policing feature.

Exceeded Bits Rate The rate of non-conforming traffic.

Violated Packets The number of packets treated as violated by the policing feature.

Violated Bits The number of octets treated as violated by the policing feature.

Violated Bits Rate The rate of the violating traffic.
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• DFP Agents, page 11-109

• DFP Real Servers, page 11-109

Virtual Server

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Virtual Server statistics table, choose Virtual Server option from the Type drop-down menu. 
The GUI displays:

Real Server

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Real server configuration and statistics table, choose Real Server option from the Type 
drop-down menu. The GUI displays:

Column Description

Virtual Server 
Name

Name of the virtual server.

Protocol Protocol for the virtual server.

IP Address IP address of the virtual server.

Port Port of the virtual server.

State State of the virtual server.

Current 
Connections

Number of currently assigned connections being handled by this virtual server.

Total Connections • Count—Number of assigned connections handled by the virtual server since 
the server was configured.

• Rate—Rate at which the assigned connections are handled by the virtual 
server since the server was configured.

Server Farm Name of the virtual server farm bound to the virtual server.

Column Description

IP Address IP Address of the real server.

Farm Name Name of the server farm of the real server.

State Current state of real server.

Current 
Connections

Number of assigned connections being handled by this real server.
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Server Farms

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Server farm configuration and statistics table, choose Server Farm option from the Type 
drop-down menu. The GUI displays:

Total Connections • Count—Number of assigned connections handled by this real server since 
this server was configured.

• Rate—Rate at which the assigned connections are handled by the real server 
since the server was configured.

Consecutive 
Connection 
Failures

Number of connection failures to this real server without a successful 
connection.

Total Connection 
Failures

• Count—Total number of times this real server has failed since the creation 
of this row.

• Rate—Rate at which the real server has failed since the creation of this row.

Administrative 
Weight

User-configured weight of the real server for the load balancing algorithms.

Operational Weight Actual operating weight of the real server used by the load-balancing algorithms.

Column Description

Column Description

Farm Name Name of the server farm.

Predictor Load balancing algorithm in use by the server farm for its real servers for the 
local SLB entity.

NAT Setting Type of NAT employed by the local SLB entity for servers in this server farm.

Number of Real 
Servers

Number of real servers in the server farm.

Bind ID Identifies one or more server farms to which the real server belongs.
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Global Statistics

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the Global Statistics table, choose this option from the Type drop-down menu. The GUI 
displays:

Field Description

Assisted Switching 
Packets

• Count—Number of packets handled by SLB which are switched via the 
highest-performance switching path.

• Rate—Rate at which the packets are handled by SLB which are switched via 
the highest-performance switching path.

Zombies • Count—Number of TCP and UDP connections currently in the zombie state 
waiting for timers to expire.

• Rate—Rate at which the TCP and UDP connections currently in the zombie 
state waiting for timers are expired.

Connections 
Reassigned

• Count—Number of TCP and UDP connections reassigned from one real 
server to another.

• Rate—Rate at which the TCP and UDP connections are reassigned from one 
real server to another.

Connections 
Destroyed

• Count—Number of TCP and UDP connections destroyed by SLB, either by 
TCPIP teardown or timeout.

• Rate—Rate at which the TCP and UDP connections are destroyed by SLB.

Connections 
Created

• Count—Number of TCP and UDP connections created since SLB was 
configured.

• Rate—Rate at which the TCP and UDP connections are created since SLB is 
configured.

Unassisted 
Switching Packets

• Count—Number of packets forwarded by the Software Load Balancing 
manager's software.

• Rate—Rate at which the packets are forwarded by the Software Load 
Balancing manager's software.

Connections 
Established

• Count—Number of connections established through SLB.

• Rate—Rate at which the connections are established through SLB.
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DFP Agents

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the DFP Agents statistics table, choose this option from the Type drop-down menu. The GUI 
displays:

DFP Real Servers

Note For toolbar details, see Using the Toolbar, page 11-6.

To view the DFP Real Servers statistics table, choose this option from the Type drop-down menu. The 
GUI displays:

Column Description

IP Address IP address of the DFP agent.

Port Port number of DFP agent.

State State of DFP agent.

Time Out Time interval during which the agent must send at least one message to the 
manager.

Retry Count Number of times the manager will attempt to re-establish a connection with the 
agent.

Agent Interval Time interval before SLB retries connecting to a DFP agent.

Column Description

IP Address IP address of the DFP agent.

Protocol Protocol of the real server.

Port Port number of real server.

Bind ID Identifies one or more server farms to which the real server belongs.

Real Weight Weight of the real server reported from a DFP agent.
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